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Preface

Welcome to Release 11i of the Oracle Mobile Field Service User Guide. This guide 
describes how to use the Oracle Mobile Field Service product. It also describes the 
application components, key concepts, features, and functions, as well as the 
application’s relationships to other Oracle or third-party applications. Because 
Oracle Mobile Field Service can be installed on a laptop computer or Pocket PC, this 
guide covers both Oracle Mobile Field Service/Laptop and Oracle Mobile Field 
Service/Pocket PC. These applications are store-and-forward types built upon 
Oracle9i Lite database technology and designed for offline usage. 

This guide assumes you have a working knowledge of the following:

■ The principles and customary practices of your business area.

■ Oracle Mobile Field Service.

If you have never used Oracle Mobile Field Service, Oracle suggests you attend 
one or more of the Oracle Mobile Field Service training classes available 
through Oracle University.

■ The Oracle Applications graphical user interface.

To learn more about the Oracle Applications graphical user interface, read the 
Oracle Applications User’s Guide.

See Other Information Sources for more information about Oracle Applications 
product information.
ix



How To Use This Guide
The Oracle Mobile Field Service User Guide describes how to use Oracle Mobile Field 
Service. The guide is composed of the following:

■ Chapter 1, "Understanding Oracle Mobile Field Service" describes what Oracle 
Mobile Field Service is and how to administer it. This chapter also describes 
how the application is structured and how you can navigate in it.

■ Part I, "Oracle Mobile Field Service/Pocket PC" contains the chapters that 
describes the installation and usage of Oracle Mobile Field Service/Pocket PC.

■ Chapter 2, "Installing Oracle Mobile Field Service/Pocket PC" describes what is 
needed to install and use the Oracle Mobile Field Service/Pocket PC 
application. It also describes how to launch the application.

■ Chapter 3, "Using Oracle Mobile Field Service/Pocket PC" describes how to use 
Oracle Mobile Field Service/Pocket PC to process service requests and tasks.

■ Part II, "Oracle Mobile Field Service/Laptop" contains the chapters that 
describes the installation and usage of Oracle Mobile Field Service/Laptop.

■ Chapter 4, "Installing Oracle Mobile Field Service/Laptop" describes what is 
needed to install and use the Oracle Mobile Field Service/Laptop application. It 
also describes how to launch the application.

■ Chapter 5, "Using Oracle Mobile Field Service/Laptop"describes how to use 
Oracle Mobile Field Service/Laptop to process service requests and tasks.

■ Appendix A, "Scheduling and Completing Tasks" describes the different levels 
of control the field service representative can exercise when doing his job.

Typographic Conventions
The following table describes the typographical conventions used in this manual:

Conventions Explanation

italics Introduces new terms that you may not be familiar with, and is 
used occasionally for emphasis.

bold Emphasizes important information. Also indicates button or 
option selections. For example, tap Next.
x



Documentation Accessibility 
Our goal is to make Oracle products, services, and supporting documentation 
accessible, with good usability, to the disabled community. To that end, our 
documentation includes features that make information available to users of 
assistive technology. This documentation is available in HTML format, and contains 
markup to facilitate access by the disabled community. Standards will continue to 
evolve over time, and Oracle is actively engaged with other market-leading 
technology vendors to address technical obstacles so that our documentation can be 
accessible to all of our customers. For additional information, visit the Oracle 
Accessibility Program Web site at http://www.oracle.com/accessibility/

Other Information Sources
You can choose from many sources of information, including documentation, 
training, and support services, to increase your knowledge and understanding of 
Oracle Mobile Field Service/Pocket PC.

If this guide refers you to other Oracle Applications documentation, use only the 
Release 11i versions of those guides.

Online Documentation
All Oracle Applications documentation is available online (HTML or PDF). 

■ PDF Documentation - See the Documentation CD provided with each release 
for current PDF documentation for your product. This Documentation CD is 
also available on OracleMetaLink and is updated frequently.

UPPERCASE Indicates the name of a file. For operating environments that use 
case-sensitive file names, the correct capitalization is used in 
information specific to those environments.

Also indicates keys or key combinations that you can use. For 
example, press the ENTER key.

monospace Indicates syntax examples, values that you specify, or results 
that you receive.

monospaced italics Indicates names that are placeholders for values; for example, 
filename.

> Indicates a selection from a menu. For example, Start > 
Programs > Oracle for Windows NT > Web-to-Go

Conventions Explanation
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■ 11i Release Content Document - Refer to the Release Content Document for 
new features listed release. The Release Content Document is available on 
OracleMetaLink.

■ About document - Refer to the About document for patches that you have 
installed to learn about new documentation or documentation patches that you 
can download. The new About document is available on OracleMetaLink.

Related Documentation
Oracle Mobile Field Service/Pocket PC shares business and setup information with 
other Oracle Applications products. Therefore, you may want to refer to other 
guides when you set up and use Oracle Mobile Field Service/Pocket PC.

You can read the guides online by choosing Library from the expandable menu on 
your HTML help window, by reading from the Oracle Applications Document 
Library CD included in your media pack, or by using a Web browser with a URL 
that your system administrator provides.

If you require printed guides, you can purchase them from the Oracle Store at 
http://oraclestore.oracle.com.

Guides Related to All Products

Oracle Applications User’s Guide
This guide explains how to enter data, query, run reports, and navigate using the 
graphical user interface (GUI). This guide also includes information on setting user 
profiles, as well as running and reviewing reports and concurrent processes.

You can access this user’s guide online by choosing “Getting Started with Oracle 
Applications” from any Oracle Applications help file.

Guides Related to Oracle Mobile Field Service

Oracle Mobile Field Service Implementation Guide 
This guide explains how to implement and administer the Oracle Mobile Field 
Service application, for either a laptop computer or Pocket PC. It covers software 
and hardware requirements, dependencies, implementation tasks, implementation 
verification, diagnostics and troubleshooting, administrative tasks, and migration 
tasks. 
xii



Installation and System Administration Guides

Oracle Applications Concepts
This guide provides an introduction to the concepts, features, technology stack, 
architecture, and terminology for Oracle Applications Release 11i. It provides a 
useful first book to read before an installation of Oracle Applications. This guide 
also introduces the concepts behind Applications-wide features such as Business 
Intelligence (BIS), languages and character sets, and Self-Service Web Applications.

Installing Oracle Applications
This guide provides instructions for managing the installation of Oracle 
Applications products. In Release 11i, much of the installation process is handled 
using Oracle Rapid Install, which minimizes the time to install Oracle Applications 
and the Oracle technology stack by automating many of the required steps. This 
guide contains instructions for using Oracle Rapid Install and lists the tasks you 
need to perform to finish your installation. You should use this guide in conjunction 
with individual product user guides and implementation guides.

Oracle Applications Implementation Wizard User Guide
If you are implementing more than one Oracle product, you can use the Oracle 
Applications Implementation Wizard to coordinate your setup activities. This guide 
describes how to use the wizard.

Upgrading Oracle Applications
Refer to this guide if you are upgrading your Oracle Applications Release 10.7 or 
Release 11.0 products to Release 11i. This guide describes the upgrade process and 
lists database and product-specific upgrade tasks. You must be either at Release 10.7 
(NCA, SmartClient, or character mode) or Release 11.0, to upgrade to Release 11i. 
You cannot upgrade to Release 11i directly from releases prior to 10.7.

“About” Document
For information about implementation and user documentation, instructions for 
applying patches, new and changed setup steps, and descriptions of software 
updates, refer to the ”About” document for your product. ”About” documents are 
available on OracleMetaLink for most products starting with Release 11.5.8.

Maintaining Oracle Applications
Use this guide to help you run the various AD utilities, such as AutoUpgrade, 
AutoPatch, AD Administration, AD Controller, AD Relink, License Manager, and 
xiii



others. It contains how-to steps, screenshots, and other information that you need to 
run the AD utilities. This guide also provides information on maintaining the 
Oracle applications file system and database.

Oracle Alert User’s Guide
This guide explains how to define periodic and event alerts to monitor the status of 
your Oracle Applications data.

Useful Implementation Documentation

Oracle Applications Product Update Notes
Use this guide as a reference for upgrading an installation of Oracle Applications. It 
provides a history of the changes to individual Oracle Applications products 
between Release 11.0 and Release 11i. It includes new features, enhancements, and 
changes made to database objects, profile options, and seed data for this interval.

Oracle Workflow User's Guide
This guide describes how Oracle Applications users can view and respond to 
workflow notifications and monitor the progress of their workflow processes.

Oracle Applications Flexfields Guide
This guide provides flexfields planning, setup and reference information for the 
Oracle Mobile Field Service/Pocket PC implementation team, as well as for users 
responsible for the ongoing maintenance of Oracle Applications product data. This 
guide also provides information on creating custom reports on flexfields data.

Oracle eTechnical Reference Manuals
Each eTechnical Reference Manual (eTRM) contains database diagrams and a 
detailed description of database tables, forms, reports, and programs for a specific 
Oracle Applications product. This information helps you convert data from your 
existing applications, integrate Oracle Applications data with non-Oracle 
applications, and write custom reports for Oracle Applications products. Oracle 
eTRM is available on OracleMetaLink
xiv



Training and Support

Training
Oracle offers a complete set of training courses to help you and your staff master 
Oracle Mobile Field Service/Pocket PC and reach full productivity quickly. These 
courses are organized into functional learning paths, so you take only those courses 
appropriate to your job or area of responsibility.

You have a choice of educational environments. You can attend courses offered by 
Oracle University at any one of our many education centers, you can arrange for 
our trainers to teach at your facility, or you can use Oracle Learning Network 
(OLN), Oracle University's online education utility. In addition, Oracle training 
professionals can tailor standard courses or develop custom courses to meet your 
needs. For example, you may want to use your organization structure, terminology, 
and data as examples in a customized training session delivered at your own 
facility.

Support
From on-site support to central support, our team of experienced professionals 
provides the help and information you need to keep Oracle Mobile Field 
Service/Pocket PC working for you. This team includes your technical 
representative, account manager, and Oracle’s large staff of consultants and support 
specialists with expertise in your business area, managing an Oracle server, and 
your hardware and software environment.
xv



Do Not Use Database Tools to Modify Oracle Applications Data
Oracle STRONGLY RECOMMENDS that you never use SQL*Plus, Oracle Data 
Browser, database triggers, or any other tool to modify Oracle Applications data 
unless otherwise instructed.

Oracle provides powerful tools you can use to create, store, change, retrieve, and 
maintain information in an Oracle database. But if you use Oracle tools such as 
SQL*Plus to modify Oracle Applications data, you risk destroying the integrity of 
your data and you lose the ability to audit changes to your data.

Because Oracle Applications tables are interrelated, any change you make using 
Oracle Applications can update many tables at once. But when you modify Oracle 
Applications data using anything other than Oracle Applications, you may change a 
row in one table without making corresponding changes in related tables. If your 
tables get out of synchronization with each other, you risk retrieving erroneous 
information and you risk unpredictable results throughout Oracle Applications.

When you use Oracle Applications to modify your data, Oracle Applications 
automatically checks that your changes are valid. Oracle Applications also keeps 
track of who changes information. If you enter information into database tables 
using database tools, you may store invalid information. You also lose the ability to 
track who has changed your information because SQL*Plus and other database 
tools do not keep a record of changes.

About Oracle
Oracle develops and markets an integrated line of software products for database 
management, applications development, decision support, and office automation, 
as well as Oracle Applications, an integrated suite of more than 160 software 
modules for financial management, supply chain management, manufacturing, 
project systems, human resources and customer relationship management.

Oracle products are available for mainframes, minicomputers, personal computers, 
network computers and personal digital assistants, allowing organizations to 
integrate different computers, different operating systems, different networks, and 
even different database management systems, into a single, unified computing and 
information resource.

Oracle is the world’s leading supplier of software for information management, and 
the world’s second largest software company. Oracle offers its database, tools, and 
applications products, along with related consulting, education, and support 
services, in over 145 countries around the world.
xvi



Understanding Oracle Mobile Field S
1

Understanding Oracle Mobile Field Service

This chapter describes what is Oracle Mobile Field Service and how to administer it. 
This chapter also describes how the application is structured and how you can 
navigate in it.

1.1 About Oracle Mobile Field Service
Oracle Mobile Field Service is part of the Oracle Field Service suite of products. (See 
the "Overview of the Oracle Field Service Suite" on page 1-2 for complete details.) 
This application is a disconnected-solution that enables a field service 
representative to service a customer in a fully automated and computer-efficient 
way. This means that schedules are received and updated in a timely manner and 
service requests are resolved quickly.

With the power of Oracle Mobile Field Service, the information gap between the 
service organization and the field service representative is eliminated. For instance, 
field service representatives automatically receives the customer service history 
with the service request. Equipped with this information, they can better carry out 
their responsibilities at the customer site. Likewise, field service representatives are 
aware of any customer install base information since this is downloaded as part of 
the service request. This information is detailed and includes all the counter 
readings for the customer product. If replacement parts are need for a customer 
product, the field service representative can access the robust spare parts 
management feature of Oracle Mobile Field Service. When field service 
representative have completed their task, they can report the labor, materials, and 
expenses incurred during their work. This information can then be sent back to the 
service organization at electronic speed so that an invoice can be given to the 
customer in a timely manner. All this automation enables you to reduce your 
operating and administrative costs, thus giving you a competitive edge and 
ultimately increasing your service revenues.
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Overview of the Oracle Field Service Suite
Because the Oracle Mobile Field Service runs on a Pocket PC, it is highly mobile and 
usable. The service request, and all associated information, is stored locally on the 
Pocket PC. This enables field service representatives to work in all places 
independent of network coverage. The dispatcher sends a job to the field service 
representative using Oracle Service Online, Oracle’s field service application. 

1.2 Overview of the Oracle Field Service Suite
The Oracle Field Service suite supports an automated process used by service 
organizations to manage their field service operations. It assists in the entire service 
process from taking the customer call to fixing and reporting on the problem at a 
customer site. The Oracle Field Service suite offers a range of products to meet your 
organization's business needs. The following table lists all the products in the suite.

Suite Application Description 

Customer Care Customer Care is not really a product of the Oracle 
Field Service suite but the Service Request form is 
delivered with the Oracle Field Service application. 
The Service Request form takes the customer's call for 
service and creates a service request.

CRM Foundation The products in CRM Foundation are essential to use 
Oracle Field Service. They are used to create tasks, 
territories, define resources, and help in the 
assignment of tasks to resources. CRM Foundation 
comes with Oracle Field Service.

Oracle Field Service This application assists in assigning tasks to service 
representatives, creating and dispatching daily 
schedules, monitoring progress, and reporting on 
material, expense, and labor transactions.

Scheduler This application enables optimization of scheduling 
capabilities of tasks to qualified resources. It takes into 
account driving time, distance, and part availability, 
and it creates part reservations.

Spares Management This application is used to provide additional logistics 
and planning features to manage a service parts 
inventory in a multi-location environment.

Mobile Application Foundation This application consists of a mobile client and a 
central application. It provides data transport between 
the Oracle enterprise system and the Oracle mobile 
client database.
1-2 Oracle Mobile Field Service User Guide



The Oracle Field Service Process
1.3 The Oracle Field Service Process
The field service process has six basic steps. This process starts with the creation of a 
service request. The service request has at least one task, which is completed by a 
field service representative in the field. After completing a task, the field service 
representative electronically submits the task details to the home office, which is 
now able to create an invoice. The field service process is driven by the service 
request status and task status changes, electronically exchanged between the field 
service representative and home office. The basic steps of the field service process 
are described in the following table:

Oracle Mobile Field 
Service/Laptop

This application is a disconnected application typically 
installed at a service representative's laptop to receive 
his daily schedule and report on progress, material, 
expense, and labor.

Oracle Mobile Field 
Service/Pocket PC

This application is a disconnected application for a 
Pocket PC so field service representatives can receive 
their daily schedule and report on progress, material, 
expense, and labor.

Steps Description 

1. Service request 
intake and 
validation

There are several ways to report a request for service. The 
customer can create the request by using the Web, Computer 
Telephone Integration (CTI), e-mail, or by dialing into a call 
center where an agent takes the call. A service request can also 
be created by a field service representative through a project or 
by a sales order (installation of a product). When the request is 
received, the customer, product and contract are checked in the 
validation step.

2. Service request 
screening and 
qualification 

After a service request is created, it is screened to avoid a field 
visit. The service request is analyzed by a support agent who 
searches the knowledge base for a solution. As an outcome of 
this process, the request may be closed, a part may be shipped to 
the customer, or the customer might ship the part for in-house 
repair. When a field visit is required, a task is created based on 
the problem description and action needed to resolve the 
problem. A definition for the parts necessary to resolve the task 
is also given. The creation of a task for installation or 
maintenance of customer product can be created automatically 
from a service contract or sales order.

Suite Application Description 
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The Oracle Field Service Process
The component in step 4, Service request delivery and reporting, can be applied 
using Oracle Mobile Field Service. In this application, the schedule is received by 
the service representative on his Pocket PC. He records counter readings and 
reports on material used, labor time, and expenses incurred.

3. Service request 
planning and 
dispatch

The tasks must be scheduled, assigned, and dispatched to the 
field service representative. The scheduling of the tasks is done 
based on various constraints such as skills, location, availability, 
and required parts. When the tasks assignment is done, the task 
or schedule is dispatched to the service representative. The 
service representative receives notification and progress on the 
task is monitored.

4. Service request 
delivery and 
reporting

Once the field service representative receives an assigned task or 
schedule, he can begin service at the customer site. He reports 
on progress, materials used and recovered, expenses, and labor 
time. Additionally, he can record counter readings and describe 
how the problem was resolved. It might be necessary to create 
new tasks or service requests if the field service representative 
cannot help the customer immediately. He can recover the 
product or product part for repair. All the reported information 
is used for billing the customer. Reporting on materials-used 
also results in automatic replenishment of the inventory in the 
service vehicle.

5. Service request 
monitoring 

Unforeseeable events can occur that impact the progress of a 
task. In this case, escalations can be raised to indicate this 
situation.

6. Service request 
completion and 
billing 

When the field service representative completes a task, he sets 
the task status as COMPLETE and moves on to the next task. 
The task information is checked by an agent at the home office 
for any service contract coverage and then an invoice is created. 
The inventories, sub-inventories, and install base are all 
updated.

Note: Depending on your service organization, the above steps 
can be separated or combined.

Steps Description 
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1.4 Navigation Path of Oracle Mobile Field Service/Pocket PC
This diagram shows the high-level structure of Oracle Mobile Field Service/Pocket 
PC. 

In Oracle Mobile Field Service, there are screens with and without global 
functionality. A screen that has global functionality contains various global icons in 
the lower portion of the screen. See "Using Global Functionality" on page 3-5 for 
further details. In the above diagram, text within a rectangle represents a screen 
with global functionality.

The Task List screen is where you start in Oracle Mobile Field Service/Pocket PC. 
The Task List screen is the "Home" screen. From this screen, you can access your 
tasks for the current day or all the tasks assigned to you, both past, present, and 
future. From the Task List screen, you can locate a desired task by either opening 
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the Search Customers screen to access the task for a desired customer or you can 
open the Search Task screen to access the desired task. Also from the Task List 
screen, you can create a part order in the New Order screen and then monitor the 
part order status in the View Order screen. Other functions you can perform from 
the Tasks List screen include viewing and creating notes, opening the Task screen, 
and accessing the Mail Inbox and Outbox.

A task is described in the Task screen. From this screen, you can access and create 
task notes and you can also access any customer product information, and the SR 
(Service Request) Details, customer information, and Debrief screens. 

The SR screen is where you can access product information and open the All Tasks, 
Create Task, and SR History screens. In addition, you can open and create service 
request notes and access service request flexfield information.

The Customer Information screen is where you can view the customer’s address 
and access and create customer notes and any Party Information flexfields. From 
this screen, you can also access the All Products, All SRs, and Create SR screens. 

From the Debrief screen, you can access any Additional Debrief Headers Info 
flexfield information. Also from this screen, you can open the Credit Card and 
signature screens. The Debrief screen is where you can view the labor time, 
materials, and expenses incurred while completing the service request. 

From the All Tasks screen, you can view all the tasks for the current service request. 
From this screen, you can open the Task screen.

The Create Task screen enables you to create a task and access task flexfields in the 
Task Additional Information screen.

The SR History screen provides you with service request history. From this screen, 
you can also open the Debrief screen. 

From the Counters screen, you can set, reset, and change readings. You can also 
access the Reset Counter screen from here.

See the appropriate sections in this guide for more details about each screen.
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1.5 Navigation Path of Oracle Mobile Field Service/Laptop
The following diagram shows the high-level structure of the Oracle Mobile Field 
Service/Laptop application. 

* You can order parts to replenish your subinventory. Also, you can transfer parts across 
subinventories. See "Ordering a Part" on page 5-85 for a complete description of these 
procedures.

The Preferences, Synchronize, Logout, and Help text in the above figure represents 
the global buttons. See "Global Button Functionality" on page 5-100 for complete 
details. The Home, Calendar, Information, and Messaging headers in the above 
figure represent the four navigational tabs in the Oracle Mobile Field 
Service/Laptop application. The Home page is where you view how many tasks on 
your laptop computer are at a particular status. The Calendar page is where you 
view all of the scheduled tasks assigned to you for either the day or week, 
depending on the view you are in. The Information page is the central point for 
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finding all the information about customer, service requests, and tasks. The 
Messaging page is where you send and receive messages to other people within 
your organization. See the appropriate sections in this guide for more details about 
each page.
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Part I

  Oracle Mobile Field Service/Pocket PC

This part contains the following chapters that describes the installation and usage of 
Oracle Mobile Field Service/Pocket PC:

■ Chapter 2, "Installing Oracle Mobile Field Service/Pocket PC"

■ Chapter 3, "Using Oracle Mobile Field Service/Pocket PC"
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2

Installing Oracle Mobile Field

Service/Pocket PC

The Oracle Mobile Field Service/Pocket PC application is installed from a desktop 
PC. First, you download and install the application onto a PC. Then you 
synchronize the Pocket PC with the PC to transfer the software onto the Pocket PC. 

This chapter describes the installation requirements for the Oracle Mobile Field 
Service/Pocket PC application. It also describes how to launch the application on 
the Pocket PC.

2.1 Minimum Hardware Requirements
This section describes the minimal desktop PC and Pocket PC hardware necessary 
to run the Oracle Mobile Field Service/Pocket PC application.

2.1.1 Desktop PC Hardware Requirements
The following are the minimal hardware necessary to download and install the 
application onto a desktop PC: 

■ Computer: IBM-compatible with Pentium I processor

■ Disk space: 50 MB free space

■ Monitor: 256 color display

■ RAM: 32 MB

■ Other requirements: serial port, Internet connection, mouse or pointer device
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2.1.2 Pocket PC Hardware Requirements
The following is the minimal hardware necessary to run the Oracle Mobile Field 
Service/Pocket PC application on a Pocket PC: 

■ Pocket PC 2000, Pocket PC 2002, Pocket PC 2003 device

■ Processor supported:

■ ARM 

■ XScale

■ 16 MB RAM

2.2 Minimum Software Requirements
This section describes the minimal PC and Pocket PC software necessary to run the 
Oracle Mobile Field Service/Pocket PC application.

2.2.1 Desktop PC Software Requirements
The following are the minimal software necessary to install the application from a 
PC: 

■ Operating System: Windows NT 4.0 (Service Pack 5), Windows 2000, Windows 
XP, or Windows ME

■ ActiveSync 3.6 and above

2.2.2 Pocket PC Software Requirements
The following is the minimal software necessary to run the application: 

■ Operating System: Pocket PC 2000, Pocket PC 2002, Pocket PC 2003
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2.3 Minimum Pocket PC Communication Requirements
The Pocket PC can synchronize over any network that supports HTTP. This 
includes the following type of communications:

■ Wired modem

■ Wireless modem

2.4 Installing the Application on Your Pocket PC
For the minimum hardware and software requirements for a Pocket PC, see 
"Minimum Hardware Requirements" on page 2-1 and "Minimum Software 
Requirements" on page 2-2.

To install Oracle Mobile Field Service/Pocket PC on your Pocket PC, complete the 
procedures in the order listed in the following table:

2.4.1 Downloading and Installing the Oracle9i Lite Setup Program
Perform this procedure from the client PC desktop. In this procedure, you will 
download the mobile client from the Mobile Server and install the Oracle9i Lite 
setup program. 

Steps
1. Open your browser.

2. Enter the following URL in your browser, where <Mobile Server> is the domain 
name or IP address of the Mobile Server: 

http://<Mobile Server>/setup

For example: http://130.35.88.214:8000/setup

Procedure Performed At

1. Downloading and Installing the Oracle9i Lite Setup 
Program 

Client PC (the PC that the 
Pocket PC HotSyncs to)

2. Configuring mSync on the Pocket PC Pocket PC

3. Performing a Full Synchronization Pocket PC

4. Launching Oracle Mobile Field Service/Pocket PC Pocket PC
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3. Click the link to download the mobile client for WinCE 3.0 on Pocket PC 
StrongARM setup program and save it. 

If you are using Internet Explorer, right click with the mouse, choose the option 
Save target as, and then click OK. Choose a location to save the setup program 
and click Save.

4. Using Windows Explorer, double click the setup.exe file that you just 
downloaded in order to run the setup program.

Once started, the setup program prompts you to specify an install directory.

5. Choose an install directory, for example, C:\ora_HOME, and then click OK. 

The Setup program downloads all the required components.

2.4.2 Synchronizing the Client Desktop PC with the Pocket PC
Complete this procedure to synchronize the client desktop PC with the Pocket PC. 
This synchronization puts the Oracle9i Lite components, Oracle Mobile Field 
Service/Pocket PC, and the database on the Pocket PC.

Steps
1. Connect the Pocket PC to the client desktop PC. 

2. If you have not installed the Microsoft ActiveSync, install it and rerun the setup 
program.

3. Start Microsoft ActiveSync and then install Oracle9i Lite. 

Choose Tools > Add remove > [processor type], where 
[processor] is either SH3, SH4 or ARM.
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4. Perform an ActiveSync to put Oracle9i Lite components on the Pocket PC.
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You can also retrieve the application and copy the data onto the Pocket PC by 
connecting to any of the following modes:

■ Wireless

■ Infrared

■ USB

■ ActiveSync

■ Modem

2.4.3 Configuring mSync on the Pocket PC
Complete this procedure to install the Oracle Mobile Field Service/Pocket PC 
application and the database on the Pocket PC. 

Steps
1. On the Pocket PC, choose Start > Programs.

The Programs screen opens.

2. Tap the File Explorer icon.

The My Documents screen opens.

3. From the drop-down menu, choose MyDevice.

The My Device screen opens.

4. Tap the Orace folder.

The Orace screen opens containing the mSync file

5. Tap on the mSync file to open it.

The mSync screen opens.

Note: To do an ActiveSync to retrieve Oracle Mobile Field 
Service/Pocket PC itself and the data associated with it, the 
computer that hosts the ActiveSync manager must be able to 
connect to the mobile server using HTTP. Therefore, You must be 
able to connect to the mobile server through HTTP. 
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6. In the mSync screen, specify information as indicated in the following table and 
then tap Apply:

2.4.4 Performing a Full Synchronization
Perform a full synchronization to retrieve Oracle Mobile Field Service/Pocket PC 
and data.

Information Description

User Name mSync client user name. This is case insensitive. (This is 
the Mobile Field Service username.)

Password mSync client password. This is case insensitive.

Change check box Leave this check box deselected.

Save Password check box Select this check box to save the mSync username and 
password.

Server IPaddress:port

Use Proxy Select this check box if appropriate.

Force Refresh Leave this check box deselected.
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Steps
Complete the following steps to perform a full synchronization:

1. Ensure that you are connected to the network. 

2. Tap Sync to start the synchronization.

After the ActiveSync, the mobile database and the mobile application are 
replicated to the client. 

2.4.5 Launching Oracle Mobile Field Service/Pocket PC 
Complete the following procedure to launch Oracle Mobile Field Service/Pocket 
PC. 

Steps
1. On the Pocket PC, choose Start > Programs.

The Programs screen opens. 

2. Tap the File Explorer icon.

The My Documents screen opens.

3. From the drop-down menu, choose MyDevice.

The My Device screen opens.

4. Tap the Orace folder.

The Orace screen opens containing the Fieldservice.exe file

5. Click on Fieldservice.exe.

The Oracle Mobile Field Service/Pocket PC opens.

2.4.6 Creating a Shortcut for Oracle Mobile Field Service/Pocket PC
Complete the following steps to create a desktop shortcut for Oracle Mobile Field 
Service/Pocket PC:

1. Select the FieldService.exe file in the \My Device\Orace directory to get 
the selection options.

This is the same as the cut-and-paste option on the Pocket PC.

2. Choose the Copy option.

3. Go to the directory where the link is to be created.
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For example, \My Device\Windows\Start Menu. 

4. Click on the Edit option in the bottom menu bar.

5. In the Menu pop-up, select Create Shortcut. 

The application can now be accessed through the shortcut and will be listed in 
the Start Menu list of programs.

2.5 Subsequent Synchronizations
This section describes how to synchronize the database on the Pocket PC. 

Steps
1. Go to the Oracle Mobile Field Service application.

2. Go to the home page of the application.

3. Click on the mSync icon. 
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Using Oracle Mobile Field Service/Pocket

PC

This chapter describes how to use Oracle Mobile Field Service/Pocket PC to process 
service requests and tasks. This application enables you to do the following:

■ View your task list for the day or all tasks assigned to you

■ Work easily with tasks and service requests

■ Create notes for tasks and service requests 

■ View customer information

■ Create reports summarizing labor, material, and expense 

■ Set counter readings

■ Obtain an electronic signature

■ Record credit card information

■ View customer product information
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3.1 Application Overview
As a field service representative, you will have the following general responsibilities 
when using Oracle Mobile Field Service/Pocket PC:

■ Synchronize with the enterprise system at the beginning of each work day

■ Review your calendar for the day

■ Visit the customer and then update service requests and tasks

■ Report service request and task details

The following is a general outline of how a field service representative may start 
and end his work day:

1. Launch Oracle Mobile Field Service/Pocket PC

See "Launching Oracle Mobile Field Service/Pocket PC" on page 3-4.

2. Synchronize Oracle Mobile Field Service/Pocket PC with the enterprise system

See "Synchronizing with the Enterprise System" on page 3-91.

3. Review your calendar for the day.

See "Working with Your Task List" on page 3-6.

4. Open the task and view or change task information.

See "Viewing and Changing Task Information" on page 3-11.

5. Set the status of the task on which you will be working.

See "Viewing and Changing Task Information" on page 3-11.

6. Learn the customer address.

See "Viewing Customer Information" on page 3-79.

7. Review service request information.

See "Working with Service Requests" on page 3-21

■ Review contract information.

See "Viewing Contract Information" on page 3-27.

■ Review service history information.

See "Viewing Service Request History" on page 3-29.

■ Create or update a customer note if necessary.
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See "Creating and Viewing a Note" on page 3-35.

8. Set any counter and counter properties.

See Counter Readings on page 3-69.

9. Report task details.

See "Debrief Reporting" on page 3-40.

10. Repeat these steps for each task that time allows.

11. Finally, exit out of Oracle Mobile Field Service/Pocket PC.

See "Closing the Application" on page 3-93.
Using Oracle Mobile Field Service/Pocket PC 3-3



Launching Oracle Mobile Field Service/Pocket PC
3.2 Launching Oracle Mobile Field Service/Pocket PC 
Complete this procedure to launch Oracle Mobile Field Service/Pocket PC.

Steps
1. Choose Start > FieldService.

Oracle Mobile Field Service/Pocket PC opens in the Task List screen. This 
screen is the starting point in the Oracle Mobile Field Service/Pocket PC 
application. See "Working with Your Task List" on page 3-6 for a complete 
description of the Task List screen. 

2. Tap the synchronization icon in the lower portion of the screen to synchronize 
Oracle Mobile Field Service/Pocket PC with the enterprise system.

See "Synchronizing with the Enterprise System" on page 3-91 for a complete 
description of this procedure.

It is necessary to synchronize Oracle Mobile Field Service/Pocket PC before 
beginning your work to ensure that you receive and send the latest updates to 
the enterprise system.
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3.3 Using Global Functionality
Oracle Mobile Field Service/Pocket PC provides various global functions in many 
of its screens. At the bottom of these screens, you can access global functionality 
through global icons.

The following graphic shows all the possible global functionality found in Oracle 
Mobile Field Service/Pocket PC.

 

The global icons perform the following functions:

 Tap the home icon to go to the Task List screen (see "Working with Your Task 
List" on page 3-6)

 Tap the notes icon to create or view notes (see "Creating and Viewing a Note" 
on page 3-35)

 Tap the flexfields icon to view, change, or enter flexfield information

 Tap the complete icon to close the screen and return to the previous screen

 Tap the left arrow icon to return to the previous screen

 Tap the synchronize icon to synchronize Oracle Mobile Field Service/Pocket 
PC with the enterprise system (see "Synchronizing with the Enterprise 
System" on page 3-91)

 Tap the parts icon to perform spares management (see "Spare Parts 
Management" on page 3-73)

 Tap the attachment icon to view attachments for either a task or service 
request (see "Viewing a Task Attachment" on page 3-16 and "Viewing a Service 
Request Attachment" on page 3-26)

 Tap the mail icon to access messaging (see "Messaging" on page 3-88)

 Tap the help icon to go to receive general and Oracle Mobile Field 
Service/Pocket PC-specific help 
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3.4 Working with Your Task List
The Task List screen is the starting point in the Oracle Mobile Field Service/Pocket 
PC application. The Task List screen lists non-closed tasks in descending order 
based on the scheduled date and time stamp. See "Viewing a Past or Future Task 
List" on page 3-8 to view the tasks for a different day. 

 

3.4.1 Understanding the Task List Screen
The Task List screen is updated each time you synchronize with the enterprise 
system. See "Synchronizing with the Enterprise System" on page 3-91 for a complete 
description of this procedure.

You can to do the following from the Task List screen:

■ View tasks for the day

■ View all tasks assigned to you, past, present, and future

■ Access information for a selected task

■ Search for an assigned task

■ Search for a customer for which you are assigned tasks
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■ Create a parts requirement

■ View parts requirement status

■ Create a personal task

■ View the on-hand quantity of parts

3.4.1.1 The Task List Screen Table
In the following table format, the Task List screen briefly describes the tasks:

■ Column 1: Task status

■ Column 2: Task start time

■ Column 3: Task name

■ Column 4: Customer of the task

■ Column 5: Task note icon

If you tap in either the Status, Time, or Name column, Oracle Mobile Field 
Service/Pocket PC opens the Task screen for a task. See "Viewing and Changing 
Task Information" on page 3-11 for a complete description of this screen. If you click 
in the Customer column, Oracle Mobile Field Service/Pocket PC opens the 
Customer screen for a task. See "Viewing Customer Information" on page 3-79 for a 
complete description of this screen. Finally, if you click in the Notes column, Oracle 
Mobile Field Service/Pocket PC opens the Task Notes screen for a task. See 
"Creating and Viewing a Note" on page 3-35 for a complete description of this 
screen.

3.4.1.2 Task Statuses
Column 1 of the Task List screen table uses one of the following symbols to indicate 
the task status:

 Cancelled

 Rejected

 Assigned

 Interrupted

 Working

Completed

Typically, the status for a task progresses in the following order:
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1. Upon initial download to the Pocket PC, a task has a status of "Assigned". 

2. Once you review your schedule for the current day, change the status of 
"Assigned" tasks to "Accepted". 

3. Before you start working on an "Accepted" task, change its status to "Working". 

4. When you have successfully completed an "Accepted" task, change its status to 
"Completed".

See "Viewing and Changing Task Information" on page 3-11 to learn how to change 
the status of a task.

3.4.1.3 The Use of Color in the Task List Screen
The following colors are used in Oracle Mobile Field Service/Pocket PC to indicate 
the priority of a task:

■ Red—priority 1

■ Blue—priority 2

■ Green—priority 3

■ Black—priority 4

3.4.2 Viewing a Past or Future Task List
This section describes how to change to a past or future task list. There are two 
ways to do this:

■ Using the date drop-down list

■ Using the calendar bar

3.4.2.1 Using the Date Drop-down List

Steps
Complete the following steps from the Task List screen to go directly to a desired 
date:

1. Tap the date drop-down list.

A calendar appears.
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2. To change the month or year, tap the left and right arrows at the top of the 
calendar.

To change the year, continue tapping the appropriate arrow button until you 
reach the desired year and month.

Alternatively, you can change the month by tapping on the month and then 
choosing the desired month from the pop-up list.

3. To change the day, tap the desired day in the calendar.

Oracle Mobile Field Service/Pocket PC returns you to the Task List screen. Tap 
outside the calendar to return to the Task List screen without selecting a day. 
Tap Today to select the current day and return to the Task List screen.

3.4.2.2 Using the Calendar Bar

Steps
Complete the following steps from the Task List screen to go to the desired date:

■ To change the day for the active week, tap the desired day of the week in the 
calendar bar.
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The tasks for the specified day appear in the Task List screen.

■ To change the week, tap either the left or right arrow near the calendar bar.

Depending on the arrow you tap, the application retrieves the schedule for the 
day seven days before or after the date your are currently displaying on the 
Task List screen.
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3.5 Working with Tasks
A task is a unit of work within the service request. An administer creates a task 
during field service request screening and qualification in the office, or a field 
service representative creates a task when working out in the field. A task is related 
to a specific problem that needs to be resolved through a service request.

Update task status in order to keep your schedule up to date and to inform the 
dispatcher on the progress of your schedule. See "Viewing and Changing Task 
Information" on page 3-11 for a complete description of this procedure.

In Oracle Mobile Field Service/Pocket PC, you can enter various task information 
and even change some existing task information. The application also enables you 
to create a new task.

3.5.1 Viewing and Changing Task Information
From the Task screen, you can access the following information:

■ Tasks

■ Service requests

■ Customers

■ Task notes

■ Debriefs and counters

■ Customer products

Prerequisites
■ Opening a task from the Task List screen. See "Working with Your Task List" on 

page 3-6 or "Viewing All Tasks for a Service Request" on page 3-28, respectively.

Steps
Complete the following steps to view and change task information:

1. Navigate to the Task screen.

Use one of the following means to open the Task screen:

Open a Task Directly:

■ From the Task List screen, tap the desired task.
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The Task screen opens and displays various information for the selected 
task, such as customer, customer product, contract, and problem details. 

 

The following table describes the read-only information in the Task screen:

Read-only Information Description 

Task Number Located in the screen title, this is a generated number for a task.

Customer field Located in the screen title, this is the name of the customer. Tap 
this field to view additional customer product information. See 
"Viewing Customer Information" on page 3-79 for a complete 
description of this procedure.

Name field The name of the task.

Product field The name of the customer product that needs service. Tap this 
field to view additional customer product information. See 
"Viewing Customer Product Information" on page 3-84 for a 
complete description of this procedure.

Start Date field The date the service representative will begin working on the task. 
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Search for the Desired Task:

■ From the Task List screen, choose Search Tasks from the Goto menu.

The Search Tasks screen opens.

 

■ Tap OK to view all tasks.

The Search Results screen opens.

Contract field The name of the customer contract. Tap this field to view 
additional contract information. See "Viewing Contract 
Information" on page 3-27 for a complete description of this 
procedure.

Type drop-down list The type of task.

Priority drop-down list The priority in which the task is to be completed.

Esc If a task is escalated on the enterprise system, then "Esc" appears 
in the upper right corner of the of the Task screen, across from the 
screen title.

Read-only Information Description 
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To narrow your search, complete as many fields and drop-down lists as 
possible and then tap OK.

 

■ Select the desired task.

The Task screen opens and displays various information for the selected 
task, such as customer, customer product, contract, and problem details.

2. To view or add a task note, tap the note icon in the lower portion of the screen.

See "Creating and Viewing a Note" on page 3-35 for a complete description of 
this procedure.

3. To change the task status, open the Status drop-down list and make one of the 
following selections:

■ Accepted—specify when you are ready to begin work on the task

■ Cancelled—specify when if the assigned task is not necessary

■ Closed—specify when the work for the task is finished

■ Completed—specify when the work for the task is finished

■ Interrupted—specify when a task is on hold
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■ Rejected—specify if the assigned task is not applicable to the current 
situation

■ Working—specify when a task is in progress

4. To change the task start time, make the appropriate selections from the Start 
Date drop-down lists.

The default start time is the date and time the task was created.

5. To change the task end time, make the appropriate selections from the Start 
Date drop-down lists.

The default start time is the date and time the task was created.

6. To view any additional task information, tap the flexfields icon in the lower 
portion of the screen.

The Task Additional Information screen opens. 

 

This graphic is a typical view of the Task Additional Information screen. In this 
example, Context Value drop-down list, qamfs g 1 (150), qamfs g 2 (3 d), qamfs 
g 3 (3 c) are the task flexfields.
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7. Tap OK to save any work and return to the Task screen.

Tap Cancel to return to the Task screen without saving any work. 

8. To access debrief reporting, tap Debrief.

The Debrief screen opens. From this screen, you can enter information for the 
labor, material, and expense reports. See "Debrief Reporting" on page 3-40 for a 
complete description of this procedure.

9. To view the task service request, tap SR.

The SR screen opens. In this screen, you can view and change service request 
details, including the problem and resolution. See "Viewing and Changing 
Service Request Information" on page 3-21 for a complete description of this 
procedure.

10. To access any counters, tap Counters.

The Counters screen opens. In this screen, you can set and reset counter 
reading. See "Creating a New Counter Reading" on page 3-69 and "Resetting a 
Counter Reading" on page 3-71 for a complete description of these procedures.

11. To view any parts requirements status for the task, choose View Parts 
Requirement Status from the Goto menu.

See "Viewing Parts Requirement Status" on page 3-75 for a complete description 
of this procedure.

12. To specify a part for a task, choose Create Parts Requirement from the Goto 
menu.

See "Creating a Parts Requirement" on page 3-73 for a complete description of 
this procedure.

3.5.2 Viewing a Task Attachment
From the Task screen, you can open and view any attachment associated with a 
task. The attachment can vary in type, such as a .pdf, .doc, .xls, .gif, etc.

1. Navigate to the Task screen.

Note: Task flexfields are determined at the home office and cannot 
be changed or created in the field. This includes whether a field is 
read-only or not.
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See "Viewing and Changing Task Information" on page 3-11 for a complete 
description of this procedure.

2. Tap the attachment icon at the bottom of the screen.

The Attachments screen opens, displaying the attachment file name, size, and 
description.

3. Tap the file that you want to open.

The selected file opens.

Tape Done to return to the Task screen.

3.5.3 Creating a Task

Steps
Complete the following steps to create a task:

1. Navigate to the SR screen.

See "Viewing and Changing Service Request Information" on page 3-21 for a 
complete description of this procedure.
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2. Tap Create Task.

The Create Task screen opens. 

3. In the Name field, enter the name of the task that you want to create.

4. In the Description field, enter a brief description of the task.

5. From the Status drop-down list, select task status.

The default selection is Unassigned.

6. From the Type drop-down list, select the task type.

7. From the Priority drop-down list, select the task priority.

8. In the Planned Effort field, enter the planned finish time for the task.

Next to this field is a drop-down list where you select the type of time units.

Note: For a task to be automatically assigned to you, it should 
have the "Assignment" attribute and the task type should have the 
Dispatch rule. You can immediately work on a task with this 
criteria, which includes entering debrief reports.
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9. To change the task start date, select a new date from the Start drop-down list.

See "Using the Date Drop-down List" on page 3-8 for a complete description of 
this procedure.

10. To change the task start time, select a new time from the Start hours and 
minutes drop-down lists.

11. To change the task end date, select a new date from the End drop-down list.

See "Using the Date Drop-down List" on page 3-8 for a complete description of 
this procedure.

12. To change the task end time, select a new time from the End hours and minutes 
drop-down lists.

13. Tap OK to save the task.

Tap Cancel to return to the SR screen without saving the task. See "Viewing and 
Changing Service Request Information" on page 3-21 for a complete description 
of the SR screen.

3.5.4 Creating a Personal Task
A personal task is a notice to the dispatcher that you will not be available for a 
particular period. A personal task is not dispatchable or tied to a service request, 
therefore making it different from a task that is loaded onto your Pocket PC. For 
example, if you need to go to the dentist next week, you can create a personal task 
stating that you will be unavailable to service tasks for a certain period. By knowing 
your availability, the dispatcher can better schedule your tasks.

Steps
To create a personal task, complete the following steps:

1. From the Task List screen, select Create Personal Task from the Goto menu.
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2. Specify the desired information in the Create Task screen and then tap OK.

See "Creating a Task" on page 3-17 for a complete description of this procedure.
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3.6 Working with Service Requests
A service request is created when a customer contacts your organization with a 
problem. Typically, the customer representative analyzes the service request and 
assigns a task or tasks to it. Then the service request, along with all related 
information and tasks, are sent to field service representative. You can view the 
summary details of a service request in the Task List screen. See "Understanding the 
Task List Screen" on page 3-6 for a complete description of this procedure. 

In Oracle Mobile Field Service/Pocket PC, you can view, change, and create service 
requests. The application also enables you to view all the tasks for a service request.

3.6.1 Viewing and Changing Service Request Information

Prerequisites
■ Opening a task from the Task List screen. See "Working with Your Task List" on 

page 3-6.

Steps
Complete the following steps to view or change service request information:

1. Navigate to the Task List screen and tap the desired task.

The Task screen opens. See "Viewing and Changing Task Information" on 
page 3-11 for a complete description of this screen.

2. Tap SR.

The SR screen opens.
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3. Tap the Intake Date field.

The incident, service request, respond by, and resolve by times appear. These 
times are determined at the home office and cannot be changed.
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The following table describes the read-only information in the SR screen: 

Read-only Information Description 

Service request number Located in the screen title, this is a generated number for a service 
request.

For field The name of the customer. Tap this field open the Customer 
screen to view additional customer information. See "Viewing 
Customer Information" on page 3-79 for a complete description of 
this procedure.

Product field The name of the customer product that needs service. Tap this 
field to view additional customer product information. See 
"Viewing Customer Product Information" on page 3-84 for a 
complete description of this procedure.

Intake Date field The date that the service request was created.

Summary field A brief description of the customer problem.

Contract field The name of the customer contract. Tap this field to view 
additional contract information. See "Viewing Contract 
Information" on page 3-27 for a complete description of this 
procedure.

Status drop-down list The current status of the service request.
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4. To change the customer product, tap the ellipse (...) button near the Product 
field.

The Products screen opens. See "Viewing and Changing a Customer Product for 
a Task" on page 3-85 for a complete description of this procedure. 

5. To add or change customer purchase order information, enter new information 
in the Cust PO field.

6. To change the service request problem type, open the Problem drop-down list 
and make the appropriate selection. 

7. To change the service request problem resolution, open the Resolution 
drop-down list and make the appropriate selection.

8. In the lower portion of the SR screen, tap the note icon to view or add a service 
request note. 

See "Creating and Viewing a Note" on page 3-35 for a complete description of 
this procedure.

9. To view or add information in the service request flexfields, tap the flexfields 
icon in the lower portion of the screen. 

The Service Request screen opens. 

Type drop-down list The type of service request

Read-only Information Description 
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This graphic is a typical view of the Service Request screen. In this example, 
Context Value drop-down list, qamfs g 1 (150), qamfs g 2 (3 d), and qamfs g 3 (3 
c), qamfs g 4 (3 c), qamfs g 5 (3 c), qamfs g 6 (3 c), are the service request 
flexfields.

10. Tap OK to save your work and return to the SR screen.

Tap Cancel to return to the SR screen without saving your work. 

11. To view all the tasks for the current service request, tap All Tasks.

The All Tasks for SR screen opens. In this screen, you can view all the tasks for 
the service request. See "Viewing All Tasks for a Service Request" on page 3-28 
for a complete description of this procedure.

12. To create a task for the service request, tap Create Task.

The Create Task screen opens. As the screen name implies, this is where you can 
create a task. See "Creating a Task" on page 3-17 for a complete description of 
this procedure.

Note: Service request flexfields are determined at the home office 
and cannot be changed or created in the field. This includes 
whether a field is read-only or not.
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13. To view the service request history, tap SR History.

The SR History screen opens. As the screen name implies, this is where you 
view the service request history. See "Viewing Service Request History" on 
page 3-29 for a complete description of this procedure.

3.6.2 Viewing a Service Request Attachment
From the SR screen, you can open and view any attachment associated with a 
service request. The attachment can vary in type, such as a .pdf, .doc, .xls, .gif, etc.

1. Navigate to the SR screen.

See "Viewing and Changing Service Request Information" on page 3-21 for a 
complete description of this procedure.

2. Tap the attachment icon at the bottom of the screen.

The Attachments screen opens, displaying the attachment file name, size, and 
description.

3. Tap the file that you want to open.

The selected file opens.
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Tape Done to return to the SR screen.

3.6.3 Viewing Contract Information
Before performing a job, a field service representative should have as many details 
about the customer and task as possible. Part of these details is the contractual 
information. The field service representative uses this information to determine the 
following:

■ Customer entitlements

■ Service coverage

Steps
Complete the following steps to view contract information:

1. Navigate to the SR screen.

See "Viewing and Changing Service Request Information" on page 3-21 for a 
complete description of this procedure.

2. To view any contract information, tap the underlined, blue contract text.

The Contract screen opens.
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The following table describes the read-only fields of the Contract screen:
 

3. To change the business process, open the Process drop-down list and make the 
appropriate selection.

4. Tap the complete icon in the lower portion of the screen to save any changes 
and return to the Task screen.

5. In the lower portion of the Contract screen, tap the note icon to view or add a 
contract note. 

See "Creating and Viewing a Note" on page 3-35 for a complete description of 
this procedure.

3.6.4 Viewing All Tasks for a Service Request

Steps
Complete the following steps to view all the tasks associated with a service request:

1. Navigate to the SR screen.

See "Viewing and Changing Service Request Information" on page 3-21 for a 
complete description of this procedure.

2. Tap All Tasks.

The All Task for SR screen opens. 

Read-only Fields Description 

Number The number of the contract.

Description The name of the contract

Start Date The date the contract begins

End Date The date the contract ends

Entitlements table Describes the benefits of the contract, how much monetary coverage 
is provided for each benefit, and the percentage of coverage for each 
benefit
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This screen contains the service request number as part of the screen title and 
lists each task for the service request in a table. The table contains the task start 
date, number, and name.

3. To view the task description, tap the desired task.

The Task screen opens. See "Viewing and Changing Task Information" on 
page 3-11 for a complete description of this screen.

4. Tap the global arrow button in the lower portion of the Task List screen to 
return to the SR screen. See "Using Global Functionality" on page 3-5 for 
complete details.

3.6.5 Viewing Service Request History
To best service the customer, the field service representative should review the 
customer’s service history prior to making a customer visit. Oracle Mobile Field 
Service/Pocket PC can provide you with service history for either a customer or a 
customer product. Only tasks and service requests that are closed or completed can 
appear in the service history. The amount of service history gathered for a customer 
is determined in customer setup. Here, the administrator determines how many 
service requests will be used to create the service history. For example, the last three 
service requests may be compiled to create the service history.
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Steps
Complete the following steps to view service request history:

1. Navigate to the SR screen.

See "Viewing and Changing Service Request Information" on page 3-21 for a 
complete description of this procedure.

2. Tap SR History.

The SR History screen opens.

 

The following table describes the read-only fields of the SR History screen: 
 

Read-only Fields Description 

Summary A brief description of the service request

Intake Date The date that the service request was taken

Type The service request type

Severity The level of severity of the service request

Problem The problem to be fixed

Resolution The state of the service request resolution
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3. To change the service request number, make the appropriate selection from the 
SR Number drop-down list.

4. Tap the task in the Tasks table to learn more about the task.

The Task Debrief screen opens, displaying read-only debrief information about 
the selected task. For additional details about this screen and how to view 
reports, see "Debrief Reporting" on page 3-40.

5. In the Task Debrief screen, tap OK in the upper right corner near the time.

Oracle Mobile Field Service/Pocket PC returns you to the SR History screen.

3.6.6 Creating a Service Request
You can create a service request for each of the following scenarios:

■ Without having any product information 

■ With a system item 

Product The Oracle Mobile Field Service/Pocket PC-generated product code

Tasks table Task(s) associated with the service request

Read-only Fields Description (Cont.)
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■ With a known customer product (install base)

Steps
Complete the following steps to create a service request:

1. Navigate to the Customer screen.

See "Viewing Customer Information" on page 3-79 for a complete description of 
this procedure.

2. Tap Create SR.

The Create SR screen opens.

 

3. In the Summary field, briefly describe the service request.

To specify a serviceable item, you can either complete the Item and Instance fields 
or simply complete the Instance field. Specifying the Instance field automatically 
completes the Item field.

4. Tap Find near the Item field to select a serviceable item.

The Items screen opens with items and their descriptions listed in a table. 
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5. Tap the desired item.

Oracle Mobile Field Service/Pocket PC returns you to the Create SR screen.

Optionally, you can specify the desired item in the Search field and then tap Go.

6. In the Create SR screen, tap Find near the Instance field to select a serviceable 
item of the Item type.

The Items screen opens with instances, items, and their descriptions listed in a 
table.
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7. Tap the desired item.

Oracle Mobile Field Service/Pocket PC returns you to the Create SR screen.

Optionally, you can specify the desired item in the Search field and then tap Go.

8. In the Create SR screen, enter the customer purchase order in the Customer PO 
field. 

9. From the Severity drop-down list, select service request severity.

10. From the Status drop-down list, select service request status.

11. From the Type drop-down list, select the service request type.

12. From the Problem drop-down list, select the service request problem.

13. Tap OK to save the service request.

Tap Cancel to return to the Customer screen without saving the service request. 
See "Viewing Customer Information" on page 3-79 for a complete description of 
the Customer screen.

Tap Clear to clear the contents of the Create SR screen without saving the 
service request and to begin over.
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3.7 Creating and Viewing a Note
You can create notes for various reasons. For example, you may note that a power 
supply has to be replaced by a refurbished one.

You can create and view notes for the following:

■ Service request

■ Task

■ Customer 

■ Customer product

■ Contract

A note includes the following:

■ Note text

■ Current date 

■ Note type

■ Note status

To create and view a note for either a service request, task, customer, or customer 
product requires the same steps, with the only difference in screen names. 
Therefore, in this section, generic screens are used, but specific instructions are 
given when necessary.

Steps
Complete the following steps to view or add a note:

1. Navigate to the appropriate screen.

■ For a service request note, navigate to the SR screen.

See "Viewing and Changing Service Request Information" on page 3-21 for 
a complete description of this procedure.

Note: Since the creation of all these note types is the same, a 
common procedure is used to describe all note creation. In this 
procedure, the phrase <Note Kind> is used in the screen names, 
instead of specific screen names, so as to keep the screens universal.
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■ For a task note, navigate to the Task screen.

See "Viewing and Changing Task Information" on page 3-11 for a complete 
description of this procedure.

■ For a customer note, navigate to the Customer screen.

See "Viewing Customer Product Information" on page 3-84 for a complete 
description of this procedure.

■ For a customer product note, navigate to the Customer Product screen.

See "Viewing Customer Product Information" on page 3-84 for a complete 
description of this procedure.

■ For a contract note, navigate to the Contract screen.

See "Viewing Contract Information" on page 3-27 for a complete description 
of this procedure.

2. In the lower portion of the screen, tap the note icon to view or add a note.

Depending on the kind of note that you are creating, either the SR Notes, Task 
Notes, Customer Notes, or Product Notes screen opens.

3. Select the Create Note check box to create a note. 
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The cursor appears in the note field and the Type drop-down list becomes 
active with the Action default selection and the Status drop-down list becomes 
active with the Public default selection.

4. Enter the note text in the note field.

5. If you are not satisfied with the default note type, then make the appropriate 
selection from the Type drop-down list.

6. If you are not satisfied with the default note status, then make the appropriate 
selection from the Status drop-down list.

7. Tap OK.

The new note is now listed in the Recent Notes field along with the creation 
date.

8. To view more of the note text, either tap the note or tap Show All.

In the first case, the text for the selected note appears in the Create Note field. In 
the second case, the note text and date for all notes appear in the either the SR 
Notes, Task Notes, Customer Notes, or Product Notes screen, depending on the 
kind of note that you are creating.

9. To add another note, tap Add.

Depending on the kind of note that you are creating, either the SR Note, Task 
Note, Customer Note, or Product Note screen opens with the Action default 
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selection in the Type drop-down list and the Public default selection in the 
Status drop-down list.

10. If you are not satisfied with the default note type, then make the appropriate 
selection from the Type drop-down list.

11. If you are not satisfied with the default note status, then make the appropriate 
selection from the Status drop-down list.

12. Enter the note text in the note field.

13. Tap Save.

The new note appears either in the SR Notes, Task Notes, Customer Notes, or 
Product Notes screen, depending on the kind of note that you are creating.
3-38 Oracle Mobile Field Service User Guide



Creating and Viewing a Note
14. Tap Done to return to either the SR Notes, Task Notes, Customer Notes, or 
Product Notes screen, depending on the type of note that you are creating.

Tap Add to add another note. 
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3.8 Debrief Reporting
The Debrief screen is where you do debrief reporting. Debrief reporting involves 
creating and viewing different report types. 

 

After you complete a task, you can report the following information:

■ Labor Describes how much labor a task took to complete.

■ Materials Describes what materials were involved in the completion of a task. 
This includes both replacement and recovered parts. This 
information is used by the home office to replenish part inventories.

■ Expenses Describes the expenses required to complete a task.

In the Debrief screen is where you specify the task problem and resolution. The 
default problem description is Electrical Problem and the default resolution 
description is Solution to Software. Complete the following steps to change 
this information.

1. To change the default problem description, select the appropriate problem 
description from the Problem drop-down list, 

2. To change the default problem description, select the appropriate resolution 
description from the Resolution drop-down list.
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3.8.1 Creating a Labor Report Item
You create labor report items to describe how much labor time was involved in the 
completion of a task. Oracle Mobile Field Service/Pocket PC enables you to add 
labor report items regardless of the task status.

Steps
Complete the following steps to create a labor report:

1. Navigate to the Task List screen and tap the desired task.

The Task screen opens. See "Viewing and Changing Task Information" on 
page 3-11 for a complete description of this screen.

2. Tap Debrief.

The Debrief screen opens. See "Debrief Reporting" on page 3-40 for a 
description of this screen.

3. In the Debrief screen, tap Add above the Labor field.

The Labor Line screen opens with the current date and time in the Service Date 
drop-down list and the Start Time drop-down lists, respectively. The End Time 
drop-down list also contains a default value—the start time value plus one 
hour.

The Labor Line screen has various drop-down lists where you describe the 
labor report item.
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4. Tap the Activity ellipse (...) button to specify the labor activity.

The Select Activity screen opens with activities and processes listed in a table.

5. Select a labor activity.
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The Labor Line screen opens again with the selected activity in the Activity 
field.

6. From the Item drop-down list, select the labor item.

In the following steps, specify the amount of labor time used to complete the task. 
Complete either steps 7 through 9 or steps 10 and 11, according to your business 
process.

7. If you are not satisfied with the default service date, then make the appropriate 
selection from the Service Date drop-down list.

See "Using the Date Drop-down List" on page 3-8 for complete details.

8. If you are not satisfied with the default start time, then select the appropriate 
hour and minutes from the Start Time drop-down lists.

The hour values are for the 24-hour clock format. If you are selecting a time 
after 12:00 P.M., add twelve to the hour to get the 24-hour clock equivalent. For 
example, 4:30 P.M. would be entered as 16 hours and 30 minutes.

9. If you are not satisfied with the default end time, then select the appropriate 
hour and minutes from the End Time drop-down lists.

Again, the hour values are for the 24-hour clock format. 

10. In the Duration field, specify the amount of labor time that was needed to 
complete the task.

11. From the UOM drop-down list, select the unit of time that describes the value in 
the Duration field.

12. From the Justification drop-down list, make a selection that best describes the 
state of the labor report item.

It is not mandatory to complete the Justification drop-down list.

13. Tap OK.

The Debrief screen opens. The labor report item along with the start and finish 
times are listed here.

Tap Cancel to exit the Labor Line screen without saving your work.
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3.8.2 Deleting a Labor Report Item
For an open or closed task that has not been synchronized, Oracle Mobile Field 
Service/Pocket PC enables you to delete a labor report item from the labor report.

Prerequisite
■ Creating a labor report item. See "Creating a Labor Report Item" on page 3-41.

Steps
Complete the following steps to delete a labor report item:

1. For a desired task, navigate to the Report screen.

See "Creating a Labor Report Item" on page 3-41 for a complete description of 
this procedure.

2. Select the desired labor report item in the Labor field.

The Labor Line screen opens.

3. Select the labor report item that you want to delete.
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The Labor Line screen opens containing the Delete button. If Oracle Mobile 
Field Service/Pocket PC was synchronized after the creation of the desired 
labor report item, the Delete button will be disabled in the Set Labor window.

4. Tap Delete.

5. Oracle Mobile Field Service/Pocket PC returns you to the Labor window where 
the desired labor report item is no longer present.

3.8.3 Creating a Material Report Item
After you complete a task, you can record what materials were used in the 
completion of the task. The home office uses this information to replenish or replace 
needed materials, maintain the customers install base, and possibly invoice the 
customer for the materials used.

Initially, one item is associated with a service request. This can be an item from a 
customer's install base or an item from an inventory. One or more tasks are created 
for this service request and you can create a material report for each task. If multiple 
field service representatives are assigned to a task, then multiple material reports 
for a task can be created. You can also add several material report items to a 
material report. For each material report item, a separate line is created in the 
report. Oracle Mobile Field Service/Pocket PC enables you to add material report 
items regardless of the task status.
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When servicing an item, a field service representative may remove or return an old 
part and then install or use a new replacement part. Oracle Mobile Field 
Service/Pocket PC provides the functionality in the Debrief screen to describe both 
of these parts.

3.8.3.1 Creating a Material Report Item with a Pre-defined Parts List 

Steps 
Complete the following steps to create a material report item:

1. Navigate to the Task List screen and tap the desired task.

The Task screen opens. See "Viewing and Changing Task Information" on 
page 3-11 for a complete description of this screen.

2. Tap Debrief.

The Debrief screen opens. See "Debrief Reporting" on page 3-40 for a 
description of this screen.

3. Tap Use above the Materials field.

The first material item appears in the Material Line screen. The subinventory of 
the material item appears in the Sub Inventory drop-down list. The activity 
code associated with the service request Incident type appears in the Activity 
Code field. If the activity code is blank, then choose an activity code. 
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4. Click Yes to save the material item. 

If the material item is not in any of your subinventories, then an error message 
appears stating that no on hand quantity is available.

Click No to close the screen without saving the material item.

Click Return to return to the Debrief screen.

Click Other to do other debriefing.

3.8.3.2 Creating a Regular Material Report Item 

Steps
Complete the following steps to create a material report item:

1. Navigate to the Task List screen and tap the desired task.

The Task screen opens. See "Viewing and Changing Task Information" on 
page 3-11 for a complete description of this screen.

2. Tap Debrief.

The Debrief screen opens. See "Debrief Reporting" on page 3-40 for a 
description of this screen.
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3. Tap Use above the Materials field.

The Material Line screen opens with a default inventory type in the In 
drop-down list. In this example, qamfs_sub1 is the default inventory type. 
Also, the Service Date drop-down list contains a default value—the current 
date.

The Material Line screen has various drop-down lists where you describe the 
material report item.

 

4. Tap the Activity Code ellipse (...) button to specify the material activity.

The Select Activity screen opens with activities and processes listed in a table.
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5. Select a material activity.

The Material Line screen opens again with the selected activity in the Activity 
Code field.

6. Select a material report item using one of the following means:

■ From the Item drop-down list, make the appropriate selection.

■ Tap Find.

The Find Material screen opens with material names and description listed 
in a table.
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– Select the desired material report item.

In the Material Line screen, the material report item appears in the Item 
drop-down list.

Regardless of the method that you use to select the material report item, Oracle 
Mobile Field Service/Pocket PC populates the On Hand field and UOM 
drop-down list of the Material Line screen. 

7. To change the default inventory, make the appropriate selection from the In 
drop-down list.

8. Specify in the Quantity field the number items needed.

If the item is serialized, then 1 appears in the Quantity field. Change this value 
if it is not correct.

9. To add revision, lot, and instance information, tap Item Details.
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10. To change the default unit of measure, make the appropriate selection from the 
UOM drop-down list.

11. To change the default service date, make the appropriate selection from the 
Service Date drop-down list.

See "Using the Date Drop-down List" on page 3-8 for a complete description of 
this procedure.

12. From the Justification drop-down list, make a selection that best describes the 
state of the material report item.

It is not mandatory to complete the Justification drop-down list.

13. Tap OK.

The new material report item now appears in the Materials field of the Debrief 
screen.

Tap Cancel to exit the Material Line screen without saving your work. Tap Add 
Another to save your work and create another material report item.

3.8.3.3 Creating a Material Report Item for a Return

Steps
Complete the following steps to create a material report item:
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1. Navigate to the Task List screen and tap the desired task.

The Task screen opens. See "Viewing and Changing Task Information" on 
page 3-11 for a complete description of this screen.

2. Tap Debrief.

The Debrief screen opens. See "Debrief Reporting" on page 3-40 for a 
description of this screen.

3. Tap Return above the Materials field.

The Material screen opens with a default inventory type in the Sub Inventory 
drop-down list. There is also default information in the Return Reason, 
Justification, and Service Date drop-down lists. The latter of these contains the 
current date.

 

4. Tap the Activity Code ellipse (...) button to specify the material activity.

The Select Activity screen opens with activities and processes listed in a table.
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5. Select a material activity.

The Material screen opens again with the selected activity in the Activity Code 
field.

6. Tap Item ellipse (...) button to select a material report item. 

The Item screen opens with the name and description of each material report 
item listed in a table.
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7. Select the desired material report item.

If there are several material report items listed in the Item screen, you can access 
the desired material report item directly by specifying information in the Item 
field or Serial Num field. Then click Go.

In the Material screen, the material report item appears in the Item field. Oracle 
Mobile Field Service/Pocket PC populates the Instance field with a default 
value and places a unit of measure in the drop-down list near the Quantity 
field. The application also places a hyperlink in the Item Details field.
3-54 Oracle Mobile Field Service User Guide



Debrief Reporting
8. To change the default instance value, tap the Instance ellipse (...) button.

The Instance screen opens.
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9. Select the appropriate item instance.

The selected instance appears in the Instance field of the Material screen.

If there are several instances listed in the Instance screen, you can access the 
desired instance directly by specifying information in the Instance field or Serial 
Num field. Then click Go.

10. To view or add item details, tap Item Details.

The Item Details screen opens with default information in the Disposition field.

 

11. In the Serial Number field and Revision field, specify the appropriate 
information and then tap OK.

12. In the Material screen, specify in the Quantity field the number items needed.

If the item is serialized, then 1 appears in the Quantity field. Change this value 
if it is not correct. 

13. To change any default information in the Material screen, make the desired 
selection from appropriate drop-down list.

14. Tap OK.

The new material report item now appears in the Materials field of the Debrief 
screen.
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Tap Cancel to exit the Material Line screen without saving your work. Tap Add 
Another to save your work and create another material report item.

3.8.4 Deleting a Material Report Item
For an open or closed task that has not been synchronized, Oracle Mobile Field 
Service/Pocket PC enables you to delete a material report item from the material 
report.

Prerequisite
■ Creating a material report item. See "Creating a Material Report Item" on 

page 3-45.

Steps
Complete the following steps to delete a material report item:

1. For a desired task, navigate to the Debrief screen.

See "Creating a Material Report Item" on page 3-45 for a complete description of 
of this procedure.

2. Tap the desired material report item in the Material field.

The Material Line screen opens containing the Delete button.
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If Oracle Mobile Field Service/Pocket PC is synchronized after the creation of 
the desired material report item, then the Delete button is disabled in the 
Material Line screen or Material screen.

3. Tap Delete.

Oracle Mobile Field Service/Pocket PC returns you to the Debrief screen where 
the desired material report item is no longer present.

3.8.5 Creating an Expense Report Item
After you complete a task, you can then enter information that describes the 
expenses associated with that task. Expenses may include such things as a meal and 
driving costs. Oracle Mobile Field Service/Pocket PC enables you to add expense 
report items regardless of the task status.

Steps
Complete the following steps to create an expense report:

1. Navigate to the Task List screen and tap the desired task.

The Task screen opens. See "Viewing and Changing Task Information" on 
page 3-11 for a complete description of this screen.
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2. Tap Debrief.

The Debrief screen opens. See "Debrief Reporting" on page 3-40 for a 
description of this screen.

3. Tap Add above the Expenses field.

The Expense Line window opens with current date in the Service Date field.

4. Tap the Activity ellipse (...) button.

The Select Activity screen opens with expense activities and processes listed in 
a table.
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5. Select an expense activity.

The Expense Line screen opens again with the selected activity in the Activity 
field. Based on your activity selection, Oracle Mobile Field Service/Pocket PC 
automatically populates the Item drop-down list.

6. If you are not satisfied with the selection in the Item drop-down list, then 
change this selection.

In the following steps, specify the amount of money used to complete the task. 
Complete either steps 7 and 8 or steps 9 and 10, according to your business process.

7. In the Amount field, specify the amount of money that was needed to complete 
the task.

8. From the Currency drop-down list, specify the currency being used.

9. In the Quantity field, specify the quantity of items used to complete the service 
request.

10. From the UOM drop-down list, select the currency being used.

11. If you are not satisfied with the date in the Service Date drop-down list, then 
change this selection.

12. From the Justification drop-down list, make a selection that best describes the 
state of the expense report item.
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It is not mandatory to complete the Justification drop-down list.

13. Tap OK.

The new expense report item now appears in the Expenses field of the Debrief 
screen.

Tap Cancel to exit the Expense Line screen without saving your work. 

3.8.6 Deleting an Expense Report Item
For an open or closed task that has not been synchronized, Oracle Mobile Field 
Service/Pocket PC enables you to delete an expense report item from the expense 
report.

Prerequisite
■ Creating an expense report item. See "Creating an Expense Report Item" on 

page 3-58.

Steps
Complete the following steps to delete a expense report item:

1. For a desired task, navigate to the Debrief screen.

See "Creating a Material Report Item" on page 3-45 for a complete description of 
of this procedure.

2. Tap the desired expense report item in the Expense field.

The Expense Line screen opens containing the Delete button.
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If Oracle Mobile Field Service/Pocket PC is synchronized after the creation of 
the desired expense report item, then the Delete button will not be present in 
the Expense Line screen.

3. Tap Delete.

Oracle Mobile Field Service/Pocket PC returns you to the Debrief screen where 
the desired expense report item is no longer present.
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3.9 Obtaining an Electronic Signature
Oracle Mobile Field Service/Pocket PC enables you to obtain a customer’s 
electronic signature for task sign off. The customer’s electronic signature indicates 
that the task is complete and that the customer has accepted your work.

Steps
Complete the following steps to obtain an electronic signature:

1. Navigate to the Task List screen and tap the desired task.

The Task screen opens. See "Viewing and Changing Task Information" on 
page 3-11 for a complete description of this screen.

2. Tap Debrief.

The Debrief screen opens. See "Debrief Reporting" on page 3-40 for a 
description of this screen.

3. Tap Sign.

The Signature screen opens with customer name in the Name field and the 
current date in the Date drop-down list. 

4. Have the customer use the Pocket PC stylus to sign in the Signature field.
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To clear a customer’s signature, tap Clear.

5. In the Name field, enter the customer name.

6. If you are not satisfied with the default date in the Date drop-down list, then 
change this selection.

See "Using the Date Drop-down List" on page 3-8 for a complete description of 
this procedure.

7. Tap OK.

Oracle Mobile Field Service/Pocket PC returns to the Report screen.

Tap Cancel to exit the Signature screen without saving a signature.
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3.10 Credit Card Information
Giving the customer the ability to pay by credit card is a convenience for both the 
customer and the service organization. Oracle Mobile Field Service/Pocket PC 
enables you to record or update the following credit card information: 

■ Credit card number

■ Expiration date

■ Credit card type

■ Customer name

With this information saved, you do not have to re-enter it. The credit card 
information is encrypted so it is secure. Only the last four digits of the credit card 
number is visible in the application.

When you synchronize with the enterprise system, the credit card information is 
validated.

3.10.1 Recording Credit Card Information

Steps
Complete the following steps to record or update credit card information:

1. Navigate to the Task List screen and tap the desired task.

The Task screen opens. See "Viewing and Changing Task Information" on 
page 3-11 for a complete description of this screen.

2. Tap Debrief.

The Debrief screen opens. See "Debrief Reporting" on page 3-40 for a 
description of this screen.

3. Tap Credit.

The Credit Card screen opens with an expiration date in the Exp Date 
drop-down lists.

Note: The credit card feature is set in a profile. Consult your field 
service administrator on the use of this feature.
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4. Complete the First Name, Middle Name, and Last Name fields with the 
appropriate customer information.

5. If you are note satisfied with the default credit card type, then make the 
appropriate selection from the Type drop-down list.

6. In the Number field, enter the customer’s credit card number.

Oracle Mobile Field Service/Pocket PC encrypts the customer credit card 
information. This is indicated with all but the last four credit card digits X’ed 
out in the Number field.

7. If you are note satisfied with the default expiration date, then make the 
appropriate selection from the Exp Date drop-down lists.

8. Tap OK.

Oracle Mobile Field Service/Pocket PC returns you to the Debrief screen.

Tap Cancel to return to the Debrief screen without saving any credit card 
information. 
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3.10.2 Deleting Credit Card Information
For credit card information that has not been synchronized, Oracle Mobile Field 
Service/Pocket PC enables you to delete this information for a task.

Prerequisite
■ Unsynchronized credit card information has been created for a task. See 

"Recording Credit Card Information" on page 3-65.

Steps
Complete the following steps to delete credit card information:

1. Navigate to the Task List screen and tap the desired task.

The Task screen opens. See "Viewing and Changing Task Information" on 
page 3-11 for a complete description of this screen.

2. Tap Debrief.

The Debrief screen opens. See "Debrief Reporting" on page 3-40 for a 
description of this screen.

3. Tap Credit.

The Credit Card screen opens with information describing the customer’s credit 
card. To ensure security, all but the last four digits of the card are X’ed out in the 
Number field.
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4. Tap Delete.

Oracle Mobile Field Service/Pocket PC clears all the fields of the Credit Card 
screen, except the Type drop-down list and the Exp Date drop-down lists.
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3.11 Counter Readings
You can log a service request for a customer product that contains a counter. A 
copier having a number-of-copies counter is an example of this.

In the Counter screen, there can be multiple readings listed for a customer product. 
For each counter, you can learn about the historic readings. You can also create new 
readings for a customer product counter. You can reset a reading as well as make 
miscellaneous readings. 

A counter reading consists of the following:

■ Name

■ Time stamp

■ Value

■ Unit of measure

3.11.1 Creating a New Counter Reading

Steps
Complete the following steps to set a counter reading:

1. Navigate to the Task List screen and tap the desired task.

The Task screen opens. See "Viewing and Changing Task Information" on 
page 3-11 for a complete description of this screen.

2. Tap Counters.

The Counters screen opens with the Number of units default selection in the 
Counter drop-down list.
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3. If you are not satisfied with counter default selection, then make the 
appropriate selection from the Counter drop-down list.

In this case, Number of units is the only counter for the customer product.

4. Select the Create Reading check box.

The Reading field and Reset button become enabled.

5. In the Reading field, enter the counter value and then tap OK.

The counter reading appears in the table.

For a description of the reset counter procedure, see "Resetting a Counter 
Reading" on page 3-71. 

Note: Depending how your counter is defined, you may have to 
enter a reading that is either less than or greater than the last 
counter reading. Or your counter may be defined with no 
restrictions.
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3.11.2 Resetting a Counter Reading

Steps
Complete the following steps to reset a counter reading:

1. Navigate to the Counters screen.

See "Creating a New Counter Reading" on page 3-69.

2. Select the desired counter reading from the table.

The selected counter reading appears in the Reading field.

3. Tap Reset.

The Reset Counter window opens.

4. In the Pre-Reset Reading field, enter the original counter reading.

5. In the Post-Reset Reading field, enter a value to reset the counter reading.

6. Optionally, enter in the Reason for Reset field a statement describing your 
reason for resetting the counter.
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7. Tap OK.

Oracle Mobile Field Service/Pocket PC returns you to the Counters screen 
where the new counter reading appears in the table.

Note: Depending how your counter is defined, you may have to 
enter a counter reading that is either less than or greater than the 
last counter reading. Or your counter may be defined with no 
restrictions.
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3.12 Spare Parts Management
Spare parts management includes creating a parts requirement and viewing parts 
requirement status.

3.12.1 Creating a Parts Requirement

Steps
Complete the following steps to order a part:

1. From the Task List screen, tap the parts icon.

2. From the Goto menu, select Create Parts Requirement.

The New Order screen opens with a default address in the Ship To field and the 
current date in the Need By field.
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3. Tap the Item ellipse (...) button.

The Parts Search window opens.

4. Select the desired part from the table.
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If you know enough information about the desired part, you can specify this in 
the Part Number field or Description field and then make your selection from 
the table.

The selected part appears in the New Order screen.

5. Tap Order.

A message appears stating the requirement number and prompting you to 
continue. Remember this part number in order to reference the part order 
status. 

6. Tap OK in the prompt.

The selected part is added to the part order. Oracle Mobile Field Service/Pocket 
PC enables you to check the status of this order. See "Viewing Parts 
Requirement Status" on page 3-75 for a complete description of this procedure.

3.12.2 Viewing Parts Requirement Status
After a parts requirement has been created, you can view parts requirement status. 

Steps
Complete the following steps to view a parts requirement status:
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1. From the Task List screen, select View Parts Requirement Status from the Goto 
menu.

The View Order screen opens.

 

2. To change the requirement number, make the proper selection from the View 
Order drop-down list.

3. To see the full shipping address, tap the equal sign (=) button.

The Address screen opens.

4. Tap Done to close the Address screen.

5. Tap OK to close the View Order screen.

3.12.3 Viewing On-hand Parts and Quantities

Steps
Complete the following steps to order a part:

1. From the Task List screen, tap the parts icon and then select Search Parts.

The Search Onhand Qty screen opens.
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2. Enter the search criteria for the desired part and then tap OK.

The Onhand Quantity screen opens with the desired part displayed.
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3. Select the desired part and then tap Done.

To locate another part, tap Search to return to the Search Onhand Qty screen.
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3.13 Viewing Customer Information 
You can view the following customer information in the Customer screen:

■ Name

■ Contact

■ Address

■ Phone number

There are two ways to open the Customer screen: from within a task or with no task 
open.

Steps
Complete the following steps to view customer information:

1. Open the Customer screen.

To Open the Customer Screen from within a Task:

■ From the Task List screen, tap the desired task.

The Task screen opens. See "Viewing and Changing Task Information" on 
page 3-11 for a complete description of this screen.

■ Tap the Customer field.

The Customer screen opens with the customer name in the screen title. In 
this example, Business World is the customer and therefore this name is in 
the screen title.
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To Open the Customer Screen with no Task Open:

■ From the Goto menu at the bottom of the Task List screen, select Search 
Customers.

The Search Customers screen opens. For each customer, this screen displays 
the customer name and address.
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■ Tap the desired customer.

The Customer screen opens with the customer name appearing in the 
screen title.
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2. To view or add information in the customer flexfields, tap the flexfields icon in 
the lower portion of the screen.

The Party Information screen opens.
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This graphic is a typical view of the Party Information screen. In this example, 
Context Value drop-down list, qamfs g 1 (150), qamfs g 2 (3 d), and qamfs g 3 (3 
c) are the customer flexfields.

3. Tap OK. 

Oracle Mobile Field Service/Pocket PC returns you to the Customer screen.

Tap More to view any additional information in the Party Information screen.

Tap Cancel to return to the Customer screen without saving any data entry.

4. In the lower portion of the Customer screen, tap the note icon to view or add a 
customer note.

See "Creating and Viewing a Note" on page 3-35 for a complete description of 
this procedure. 

5. To view all customer products, tap Products.

The All Products screen opens. In this screen, you can search for a customer 
product and then receive details about this product. See "Viewing Customer 
Product Information" on page 3-84 for a complete description of this procedure.

6. To view all service requests for a customer, tap All SRs.

The All SRs screen opens. In this screen, you can view all the service requests 
for a customer. See "Viewing All Tasks for a Service Request"  on page 3-28 for a 
complete description of this procedure.

7. To create a service request, tap Create SR.

The Create SR screen opens. In this screen, you create a service request by 
specifying various information. See "Creating a Service Request" on page 3-31 
for a complete description of this procedure.

Note: Customer flexfields are determined at the enterprise server 
level and cannot be changed or created in the field. This includes 
whether a field is read-only or not.
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3.14 Viewing Customer Product Information
Oracle Mobile Field Service/Pocket PC enables you to view the customer product 
for a task or all the products for a customer. The customer product details are 
described in the Customer Product screen.

 

The following table describes the read-only information in the Customer Product 
screen:

Read-only Fields Description 

Part number The part number for the customer product, located in the screen 
title.

Part hierarchy This field lists any "parent-child" relationships the customer 
product may have to any other parts. 

Description Describes the customer product.

Number The customer product number, generated by Oracle Mobile Field 
Service/Pocket PC.

Serial Number The serial number of the customer product.

Install Date drop down 
list

The date the customer product was installed.
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3.14.1 Viewing and Changing a Customer Product for a Task

Steps
Complete the following steps to view customer product information: 

1. Navigate to the SR screen.

See "Viewing and Changing Service Request Information" on page 3-21 for a 
complete description of this procedure.

2. Tap the Product field to view the customer product information. 

The Customer Product screen opens, displaying a product description, number 
and serial number along with the installation date and any revision 
information.

3. Tap the left arrow icon to return to the SR screen. 

4. To change the customer product, tap the ellipse (...) button near the Product 
field.

The Products screen opens. This screen lists in a table all the possible 
customer’s products, with the instance, name, and description provided.

Revision

Read-only Fields Description (Cont.)
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5. Tap the desired customer product.

The selected customer product appears in the Product field of the SR screen.

3.14.2 Viewing All Products for a Customer

Steps
Complete the following steps to view customer product information: 

1. Navigate to the Customer screen.

See "Viewing Customer Information" on page 3-79 for a complete description of 
this procedure.

2. Tap Products.

The All Products screen opens displaying in a table the customer product 
instance, name, and description.
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3. Select the desired customer product.

The Customer Product screen opens, displaying a product description, number 
and serial number along with the installation date and any revision 
information.

4. Tap Done to return to the All Products screen.
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3.15 Messaging 
This section describes how you can use messaging in the Oracle Mobile Field 
Service/Pocket PC application.

3.15.1 Messaging Functionality
The messaging function enables the field service engineer to send and receive 
messages to other people within your organization.

■ It can be used to send messages to all field service users, or to members of a 
group to which the field service representative is a member.

■ You can use this function to ask for support or additional information. For 
example, you can also use messages to request new parts.

After you synchronize, you can see any new messages in the Mail screen (inbox 
view). You can make sure that a message you wrote has been sent by seeing if it is 
listed in the Mail screen (outbox view).

3.15.2 Reading, Sending, and Deleting Messages
This section describes how to do the following:

■ Read messages that you have received 

■ Send messages to other members of the field service organization 

■ Delete messages that you have read 

Steps
Complete the following steps to read, send, and delete messages:

1. Tap the mailbox icon at the bottom of the Task List screen.

The Mail screen opens, listing all the mail in your inbox. The inbox is the 
default view.
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2. Select the message that you want to read.

The message text appears in the scrollable box near the bottom of the Mail 
screen (Inbox view).

3. To delete this message, tap Delete.

4. To create a new message, select the New Mail check box.

The user name appears in the From field.

5. Tap the To ellipse (...) button to select a recipient.

The Select Recipient screen opens with the user name and full name of all the 
possible mail recipients listed in a table.
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6. Select the recipient from the table.

The recipient appears in the To field of the Mail screen (Inbox view).

7. Type your message in the scrollable box near the bottom of the screen and then 
tap Send.

The message is sent to the recipient.

8. To view the messages that you sent, select Outbox from the drop-down list.

The Mail screen (Outbox view) displays all sent messages.

9. Select the message for which you want to view the text.

10. The message text appears box near the bottom of the screen.

11. To create and send a new message in the Mail screen (Outbox view), complete 
the steps in this procedure you used to create a new message in the Mail screen 
(Inbox view).

12. Tap Done to return to the Task List screen.
3-90 Oracle Mobile Field Service User Guide



Synchronizing with the Enterprise System
3.16 Synchronizing with the Enterprise System
In order to receive new data assigned to you, such as new tasks and service 
requests, you need to synchronize with the enterprise system. Likewise, to send the 
changes that you have made, such as creating report items and updating task 
statuses, you need to synchronize with the enterprise system.

Steps
Complete the steps below to synchronize Oracle Mobile Field Service/Pocket PC 
with the enterprise system.

1. Establish a network connection for your Pocket PC. 

2. Tap the synchronization icon near the bottom of the Task List screen.

The synchronization screen opens.

3. Complete the following fields and check boxes in the synchronization screen as 
described in the following tables:

Field Description

User Name mSync client user name. (This is the Mobile Field Service user 
name.)

Password mSync client password. This field is case sensitive.
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4. Tap Sync.

Information from your Pocket PC and enterprise system synchronize. 

Tap Apply to save your work without synchronizing. Tap Cancel to exit the 
synchronization screen without saving your work.

Server IPaddress:port 

Check box Description 

Change Leave un-selected.

Save password Select this check box to save the mSync user name and 
password.

Secure

Use Proxy Select if appropriate.

Force Refresh

Note: Synchronizing your data could take a few minutes. Do not 
abort the synchronization. If the synchronization fails with errors, 
contact your system administrator. 

Field Description
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3.17 Closing the Application 
When you have finished working in Oracle Mobile Field Service/Pocket PC, logout 
of the application. 

Prerequisites
Save all data and be ready to exit the application.

Steps
Complete the following to logout of Oracle Mobile Field Service/Pocket PC:

■ In the lower portion of the Task List screen, choose Exit from the Exit 
drop-down list.

Oracle Mobile Field Service/Pocket PC checks that all data has been correctly 
saved and then closes. The Pocket PC returns to the Pocket PC desktop where 
all the applications are listed. 
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This part contains the following chapters that describes the installation and usage of 
Oracle Mobile Field Service/Laptop:

■ Chapter 4, "Installing Oracle Mobile Field Service/Laptop"

■ Chapter 5, "Using Oracle Mobile Field Service/Laptop"
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Installing Oracle Mobile Field

Service/Laptop

This chapter describes what is needed to install and use the Oracle Mobile Field 
Service/Laptop application. It also describes how to launch the application.

4.1 Minimum Hardware Requirements
The following are the minimal hardware requirements necessary to run Oracle 
Mobile Field Service/Laptop:

■ Computer: IBM-compatible with Pentium III processor

■ Disk space: 1 GB

■ Monitor: 256 color display

■ RAM: 128 MB

■ Other requirements: serial port, internet connection, mouse or pointer device

4.2 Minimum Software Requirements
The following are the minimal software requirements necessary to run Oracle 
Mobile Field Service/Laptop:

■ Operating System: Windows NT 4.0 (Service Pack 5), Windows 98, Windows 
2000, Windows ME, or Windows XP

■ Browser: Microsoft Internet Explorer, version 5.5 or later. This is the 
recommended browser for all Oracle HTML-based applications.
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4.3 Installing the Software
This section describes how to install the Web-to-Go server and Oracle9i Lite 
database, in addition to the Oracle Mobile Field Service/Laptop application. This 
additional software is necessary for Oracle Mobile Field Service/Laptop to operate.

Steps
Complete the following steps to install Oracle Mobile Field Service/Laptop on your 
laptop computer:

1. Open a Web browser window.

2. Open the following URL, where <Mobile Server> is the domain name or IP 
address of the Mobile Server:

http://<Mobile Server>/setup

For example: http://130.35.88.214/setup

3. Click the link to download the Mobile Client for Laptop setup program and 
save it.

If you are using Internet Explorer, right click with the mouse, choose the option 
Save target as and then click OK. Choose a location to save the setup program 
and then click Save.

4. From Windows Explorer, double-click the setup.exe file that you just 
downloaded.

Once started, the setup program prompts you to specify an install directory.

5. Choose an install directory.

For example, C:\ora_HOME and then click OK. The setup program downloads 
all the required components. Once the installation is completed, your browser 
will launch. If the browser does not launch automatically, the setup program 
box will have the Web-to-Go URL displayed on it. For example, 
http://my-laptop. In this case, click the URL. 

6. After the browser launches, log on using the same user name and password 
that you use for online applications.

Note: You can always use the URL http://localhost to access 
the Web-to-Go server without needing to know the name of the 
laptop computer.
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If the browser returns a "Page Not Found" error, check your proxy settings. In 
Internet Explorer, ensure that the Bypass Proxy for Local Addresses check box is 
selected under Tools > Internet Options > Connections > LAN 
Settings. Reload the page and try again. 

7. Click Go.

The Oracle9i Lite Client Initialization page opens.
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8. Click Next.

The Oracle9i Lite Client Synchronization page opens. The initial 
synchronization downloads the application and your initial set of data. The 
synchronization takes several minutes; therefore, do not exit the browser until 
the synchronization is complete.
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After synchronization completes, the browser displays the Oracle Mobile Field 
Service/Laptop Calendar page (Daily View).
Installing Oracle Mobile Field Service/Laptop 4-5



Installing the Software
To start Oracle Mobile Field Service/Laptop after installing the application, see 
"Launching Oracle Mobile Field Service/Laptop" on page 5-3.
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Using Oracle Mobile Field Service/Laptop

This chapter describes how to use all the functionality associated with the following 
pages:

■ Calendar

■ Information

■ Messaging

■ Home

5.1 Application Overview
As a field service representative, you will have the following general responsibilities 
when using Oracle Mobile Field Service/Laptop:

■ Synchronize with the enterprise system at the beginning of each work day

■ Review your calendar for the day

■ Visit the customer and then update service requests and tasks

■ Report service request and task details

The following is a general outline of how field service representatives may start and 
end their work day:

1. Launch Oracle Mobile Field Service/Laptop.

See "Launching Oracle Mobile Field Service/Laptop" on page 5-3.

2. Synchronize Oracle Mobile Field Service/Laptop with the enterprise system.

See "Synchronizing with the Enterprise System" on page 5-100.
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3. Review your calendar for the day and then set the status of the task on which 
you will be working.

See "Viewing and Opening Tasks" on page 5-8.

4. Create a personal task if you need to communicate any unavailability.

See "Creating a Personal Task" on page 5-25.

5. Record the time before visiting the customer site.

See "Creating and Deleting a Time Report Item" on page 5-57.

6. Open the task and view or change task information.

See "Viewing and Opening Tasks" on page 5-8 and "Viewing and Changing Task 
Information" on page 5-47.

7. Review customer information.

See "Viewing Customer Information" on page 5-26

■ Review contract information.

See "Viewing Contractual Information" on page 5-41.

■ Review service history information.

See "Viewing Service History" on page 5-45.

■ Create or update a customer note if necessary.

See "Creating and Viewing Notes" on page 5-53.

8. Update or enter any service request information.

See "Viewing and Changing Service Request Information" on page 5-34.

9. Set any counter and counter properties.

See Setting Counters and Counter Properties on page 5-80.

10. Order or transfer any necessary parts needed to finish the task.

See Spares Management on page 5-84.

11. Record the time prior to leaving the customer site.

See "Creating and Deleting a Time Report Item" on page 5-57.

12. Record any materials used to complete the task.

See "Creating and Deleting a Material Report Item" on page 5-60.
5-2 Oracle Mobile Field Service User Guide



Launching Oracle Mobile Field Service/Laptop
13. Record expenses incurred while completing the task.

See "Creating and Deleting an Expense Report Item" on page 5-69.

14. Repeat these steps for each task that you complete.

15. Finally, exit out of Oracle Mobile Field Service/Laptop.

See "Logging Out" on page 5-103.

5.2 Launching Oracle Mobile Field Service/Laptop
Complete the following steps to start Oracle Mobile Field Service/Laptop:

1. Choose Start > Programs > Oracle9i Lite > Web-to-Go 

The Web-to-Go icon appears in the system tray. The system tray is located in the 
Windows taskbar, usually at the bottom of the screen. The system tray contains 
the clock and miniature icons for easy access to system functions such as 
printer, modem, and volume control.

2. Double click on the Web-to-Go icon in the system tray.

Your internet browser opens the Oracle E-Business Suite login page.
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3. Enter your user name and password in the appropriate fields and then click Go.

The Calendar page (Daily View) opens. For a complete description of this page, 
see "Using the Calendar Page" on page 5-6.
5-4 Oracle Mobile Field Service User Guide



Launching Oracle Mobile Field Service/Laptop
In order to receive new data assigned to you, such as new tasks and service 
requests, you need to synchronize with the enterprise system. Likewise, to send 
the changes that you make, such as creating debrief lines and updating task 
statuses, you need to synchronize with the enterprise system.

4. Establish a telephone / internet connection for your laptop computer. 

5. Click the Synchronize button in the upper right corner of the page. 

The information on your laptop computer is synchronized with the enterprise 
system. Synchronizing your data can take a few minutes; therefore, do not abort 
this process. If the synchronization process fails, contact your system 
administrator. 
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5.3 Using the Calendar Page 
The Calendar tab is used to access the Calendar page, which can contain the daily, 
weekly, and monthly listing of tasks assigned to you. The calendar gives you an 
immediate overview of all the tasks that need to be done for the day or week, along 
with pertinent task information, such as the scheduled task start time.
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The calendar defaults to the date of the oldest active task. For example, if a task 
from yesterday has not yet been closed or completed, Oracle Mobile Field 
Service/Laptop will display this task first in the Calendar page. The tasks for the 
current day are listed in ascending order based on the scheduled date/time, after 
any active tasks from previous days.

The following table describes what you can do from the Calendar page based on the 
page view:

Calendar Function Daily View Weekly View

Navigate to the details of a selected task Yes Limited
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5.3.1 Viewing and Opening Tasks 
The Calendar page is your starting point for each day of work. From it, you can 
learn which customers you are scheduled to visit, what tasks you will perform at 
each site, and retrieve any additional information about the listed tasks.

Steps
To view and open a task, complete the following steps: 

1. Click the Calendar tab to open the Calendar page. 

The Daily View is the default view of the Calendar page. 

To view the calendar of tasks for another day or week, see "Viewing a Past or 
Future Calendar" on page 5-11.

The Daily View of the Calendar page contains a table of tasks for the day. This 
table has multiple columns where you can access various task information.

The Weekly View of the Calendar page contains a table of tasks for the week. 
This table contains columns for each day of the week. A task appears in the 
column of the day for which it is assigned.

To open the Weekly View, click Weekly View in the Calendar tab.

2. Open the task either in the Daily View or Weekly View.

To Open the Task from the Daily View:

■ From the Calendar: Daily View table, open the task by clicking one of the 
following:

Change the status of a task Yes No

Select a past or future calendar of tasks For a day For a week

Create a personal task Yes No

Note: As shown in the table above, you must be in the Daily View 
of the Calendar page in order to change the task status and create a 
personal task. The functionality in the Weekly View is an 
abbreviation of that of the Daily View.

Calendar Function Daily View Weekly View
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– Request column—Click the desired service request number to view the 
service request details.

The Information page (Service Request Details view) opens. See "View-
ing and Changing Service Request Information"  on page 5-34 for a 
complete description of this page.

– Customer column—Click the desired customer name to view more 
information about the customer, such as the name and address of the 
customer. 

The Information page (Customer Details view) opens. See "Viewing 
Customer Information"  on page 5-26 for a complete description of this 
page.

– Task Name column—Click the desired task name to view a description 
of the task. 

The Information page (Task Details view) opens. See "Viewing and 
Changing Task Information" on page 5-47 for a complete description of 
this page.

– Product column—Click the desired customer product to view a 
description of the product.

The Information page (Search Results view) opens. See "Ordering a 
Part"  on page 5-85 for a complete description of this page.

The Calendar: Daily View table also provides the following information:

– Scheduled column—Where you can view the task scheduled start time

– Travel Time column—Where you can view the calculated or default 
travel time. 

– Task Number column—Where you can view the task number for a 
desired task.

– Status column—Where you can view and specify the current task 
status. To specify the current task status, access the status drop-down 
list for the desired task and then make the appropriate selection.

Set the status of the task and then click Update to save the status to the 
local database on your laptop computer. Choose a status from the fol-
lowing table:
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Typically, the status for a task progresses in the following order:

– Upon initial download to the laptop computer, a task has a status of 
"Assigned". 

– Once you review your schedule for the current day, change the status 
of "Assigned" tasks to "Accepted". 

– Before you start working on an "Accepted" task, change its status to 
"Working". 

– When you have successfully completed a "Working" task, change its 
status to "Completed".

To Open the Task from the Weekly View:

■ If you haven’t done so already, click Weekly View in the Calendar tab. 

The Calendar: Weekly View table appears.

■ From the Calendar: Weekly View table, open the task by clicking one of the 
following:

– Task name—Click the desired task name to view a description of the 
task. 

The Information page (Task Details view) opens. See "Viewing and 
Changing Task Information" on page 5-47 for a complete description of 
this page.

– Customer name—Click the desired customer name to view more 
information about the customer, such as the name and address of the 
customer. 

Task Status Description

Accepted Assign this status to a task once you have viewed the calendar and are ready 
to work on the task.

Assigned A task has this status when initially downloaded onto the laptop computer.

Cancelled Assign this status to a task that has been cancelled.

Closed Assign this status to a task that is now closed.

Completed Assign this status to a task once you have completed a task.

Rejected Assign this status to an assigned task that you are unable to accept.

Working Assign this status to a task once you have started to work on the task.
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The Information page (Customer Details view) opens. See "Viewing 
Customer Information"  on page 5-26 for a complete description of this 
page.

The Calendar: Weekly View table also provides the following information:

– Scheduled start time for a task

5.3.2 Viewing a Past or Future Calendar
Oracle Mobile Field Service/Laptop enables you to view the calendar of tasks for a 
past or future day or week. 

Steps
To view the calendar of tasks for a past or future day or week, complete the 
following steps:

1. Click the Calendar tab to open the Calendar page. 

The Daily View is the default view of the Calendar page. 

2. To change to the Weekly View, click Weekly View in the Calendar tab.

3. To go to the next or previous calendar of tasks, click the left or right arrow 
button. 

■ In the Daily View, the tasks for the next or previous day appears.

■ In the Weekly View, the tasks for the next or previous week appears.

4. To select a calendar day or week directly, click the calendar button near the date 
field in upper right portion of the Calendar page.

The calendar window opens.
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You can also type the date directly into the date field. If you type the date with 
the incorrect format, a warning message appears indicating this and then the 
date reverts back to its original value.

5. Use the month and year drop-down lists to display the desired month and year.

Use the left and right arrow buttons in the calendar window to go to the next or 
previous month.

6. Click on the desired date.

The calendar window closes and the selected date appears in the date field of 
Calendar page.

To exit the calendar window without selecting a date, click Cancel. To exit the 
calendar window and clear the date field of Calendar page, click Clear.

7. Click Go.

If you are in the Daily View, the task(s) for the selected date appears in the 
Calendar page. If you are in the Weekly View, the tasks for the week of the 
selected date appear in the Calendar page.

5.3.3 Using Quick Debrief 
Quick Debrief is a feature found in the Calendar page that enables you to view and 
specify general debrief information and specific labor time, expense, and material 
information from a single page. See Debrief Reporting on page 5-57 to learn more 
about debrief reporting.

Quick Debrief enables you to access debrief information for a specific service 
request. See Viewing a Past or Future Calendar on page 5-11 to choose a different 
service request. 

Steps
To access Quick Debrief, complete the following steps:

1. From the Calendar page, click the Quick Debrief page icon in the Calendar 
table, under the Quick Debrief heading.

The Quick Debrief page opens.
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2. From the Problem drop-down list, specify the type of service request problem.

3. From the Resolution drop-down list, specify the type of service request 
resolution.

4. In the SRNotes field, click Add to open the Notes window and to add a service 
request note.

See "Creating and Viewing Notes" on page 5-53 for a complete description of 
this procedure.

5. In the TaskNotes field, click Add to open the Notes window and add a task 
note.
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See "Creating and Viewing Notes" on page 5-53 for a complete description of 
this procedure.

6. For any flexfields, complete these according to your needs.

7. To add a labor time report item for a task, complete the following steps:

■ To change the default business process, make the appropriate selection from 
the Business Process drop-down list in the Time Reporting area.
5-14 Oracle Mobile Field Service User Guide



Using the Calendar Page
■ To change the default labor type, make the appropriate selection from the 
Labor Type drop-down list.

■ To change the default labor item, make the appropriate selection from the 
Labor Item drop-down list.

■ To change the default service date, specify the appropriate information in 
the Service Date field.

Use the procedure, "Viewing a Past or Future Calendar" on page 5-11, 
beginning with step 4, to change the service date. The star next to the 
Service Date field indicates that this drop-down list is required. 

In the following steps, specify the amount of labor time used to complete the 
task. According to your business process, complete the steps for either the start 
and end times or duration.

■ From the Start Time hour and minutes drop-down lists, select the time you 
started a task.

The Start Time hour drop-down list provides values for the 24-hour clock 
format. If you are selecting a time after 12:00 P.M., add twelve to the hour to 
get the 24-hour clock equivalent. For example, 4:30 P.M. would be entered 
as 16 hours and 30 minutes.

■ From the End Time hour and minutes drop-down lists, select the time you 
ended a task.

Again, the hour drop-down list provides values for the 24-hour clock 
format.

Note: The Business Process, Labor Type, and Service Date 
drop-down lists are mandatory. To specify the length of the task, 
either the Start Time and End Time fields are mandatory or the 
Duration field and UOM drop-down list are mandatory. Specify the 
length of time using one of these pairs, but not both.

Note: The labor item is optional. If you keep the Labor Item 
drop-down list blank, then it is mandatory that you specify values 
in the Start Time and End Time fields, but nothing in the Duration 
field and UOM drop-down list.
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■ In the Duration field, enter the length of time the task took to complete.

■ From the UOM drop-down list, select the unit of time that describes the 
value in the Duration field.

■ From the Reason drop-down list, select the reason for spending the 
specified labor time on the task.

■ Click Add.

The labor time report item is saved and added to the time report. In the 
table in the Time Reporting area, the new labor time report item is now 
listed.

To clear the information that you specified for the labor time report item, 
click Clear. To delete a labor time report item from the report, select the 
check box near the desired report item and then click Delete selected.

For an open or closed task that has not been synchronized, Oracle Mobile 
Field Service/Laptop enables you to delete a labor report item from the 
labor report.

8. To add an expense report item for a task, complete the following steps:

■ To change the default business process, make the appropriate selection from 
the Business Process drop-down list in the Expense Reporting area.
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■ To change the default business process, Customer Support, make the 
appropriate selection from the Business Process drop-down list. 

Note: The Business Process, Expense Type, and Expense Item, and 
Service Date drop-down lists are mandatory. To specify the expense 
of the task, either the Quantity filed and UOM drop-down list are 
mandatory or the Cost field and Currency drop-down list are 
mandatory. Specify the expense using one of these pairs, but not 
both.
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■ To change the default expense type, make the appropriate selection from 
the Expense Type drop-down list.

■ To change the default expense item, make the appropriate selection from 
the Expense Item drop-down list.

■ To change the default service date, specify the appropriate information in 
the Service Date field.

Use the procedure, "Viewing a Past or Future Calendar" on page 5-11, 
beginning with step 4, to change the service date. 

■ Specify the cost and currency that describes the expense. 

The Quantity field and UOM drop-down list are used together while the 
Cost field and Currency drop-down list are paired together. In your 
description, complete only one of these field-and-drop-down list 
combinations.

– Complete the Quantity field and UOM drop-down list if the pricing 
amount is unknown.

– In the Cost field, enter the cost of completing the task. In the Currency 
drop-down list, ensure that the default currency is correct. If necessary, 
change it to the correct currency. 

■ In the Justification drop-down list, select the reason for spending the 
specified expense on the task.

■ Click Add.

The expense report item is saved to your laptop computer. In the table in 
the Expense Reporting area, the new expense report item is now listed.

To clear the information that you specified for the expense report item, click 
Clear. To delete an expense report item from the report, select the check box 
near the desired report item and then click Delete selected.

For an open or closed task that has not been synchronized, Oracle Mobile 
Field Service/Laptop enables you to delete an expense report item from the 
expense report.

There are two versions of the Material Reporting area of the Quick Debrief page: 
one for used parts and the other for recovered parts. In both versions, there are 
default values for the Business Process and Transaction Type drop-down lists.

9. To add a material report item for a task, complete the following steps:
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■ To change the default business process, make the appropriate selection from 
the Business Process drop-down list in the Material Reporting area.

The business process selection determines the selection in the Transaction 
Type drop-down list. The selection in this drop-down list determines 
whether fields and drop-down lists for a used or recovered part appear in 
the Material Reporting area of the Quick Debrief page. 

■ To change the default transaction type, make the appropriate selection from 
the Transaction Type drop-down list. 
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Adding a Used Part 

■ Click Find without completing any fields or drop-down lists.

The Search Materials window opens.

■ Click Find without completing any fields.

The Search Materials area appears in the Search Materials window.

■ Select the desired part from the Search Materials area.

The Search Materials window closes and the selected material report item 
appears in the Used Part table.

■ To change the default service date, specify the appropriate information in 
the Service Date field.

Use the procedure, "Viewing a Past or Future Calendar" on page 5-11, 
beginning with step 4, to change the service date.

■ To change the default quantity, specify the correct value in the Quantity 
field.

■ To change the default unit of measure, specify the correct information in the 
UOM drop-down list.

■ From the Reason drop-down list, select the reason for adding the specified 
part.

■ Click Add.
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The material report item is saved and added to the material report. In the 
table in the Material Reporting area, the new material report item is now 
listed.

To clear the information that you specified for the material report item, click 
Clear. To delete a material report item for a used part from the report, select 
the check box near the desired report item and then click Delete selected.

For an open or closed task that has not been synchronized, Oracle Mobile 
Field Service/Laptop enables you to delete a material report item from the 
material report.

Adding a Recovered Part

■ Click Find without completing any fields or drop-down lists.

The Customer Products window opens.

■ Select the desired service request.

The Customer Products window displays a recovered install base part.
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■ Click OK.

The Customer Products window closes and the selected material report 
item appears in the Recovered Part table.

■ To change the default service date, specify the appropriate information in 
the Service Date field.

Use the procedure, "Viewing a Past or Future Calendar" on page 5-11, 
beginning with step 4, to change the service date.

■ To change the default quantity, specify the correct value in the Quantity 
field.

■ To change the default unit of measure, specify the correct information in the 
UOM drop-down list.

■ To change the default inventory, specify the correct information in the 
Inventory drop-down list.

■ From the Reason drop-down list, select the reason for adding the specified 
part.

■ Click Add.
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The material report item is saved and added to the material report. In the 
table in the Material Reporting area, the new material report item is now 
listed.

To clear the information that you specified for the material report item, click 
Clear. 

10. To delete a material report item for a recovered part from the report, select the 
check box near the desired report item and then click Delete selected.

For an open or closed task that has not been synchronized, Oracle Mobile Field 
Service/Laptop enables you to delete a material report item from the material 
report.

11. View sign off information.
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The customer name, current date, and space for a signature appear at the 
bottom of the Quick Debrief page. You can print this page and have the 
customer sign off for the task in the signature area.

12. Click Calendar to return to the Calendar page.

Click Task Details to open the Information page (Task Details view) and view 
all the details for the task.
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5.3.4 Creating a Personal Task
A personal task is a notice to the dispatcher that you will not be available for a 
particular period. A personal task is not dispatchable or tied to a service request, 
therefore making it different from a task that is loaded onto your laptop computer. 
For example, if you need to go to the dentist next week, you can create a personal 
task stating that you will be unavailable to service tasks for a certain period. By 
knowing your availability, the dispatcher can better schedule your tasks.

Steps
To create a personal task, complete the following steps:

1. Click the Calendar tab to open the Calendar page. 

The Daily View is the default view of the Calendar page.

2. Click Create Personal Task.

The Calendar page displays the Create Personal Task view.

3. From the Type and Status drop-down lists, select the appropriate information.

4. Complete the Name field with the appropriate information.

5. Complete or modify any other fields in this window.

6. Click Create.

Oracle Mobile Field Service/Laptop creates a personal task and then returns 
you to the Calendar: Daily View of the Calendar page.

Note: The Type and Status drop-down lists are mandatory along 
with the Name field.
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5.4 Using the Information Page
The Information page is the central point for finding all the information about 
customers, service requests, and tasks. Whenever you request information from 
anywhere in the application, your request is linked to the Information page. This 
means that the Oracle Mobile Field Service/Laptop application will take you to the 
Information page when you search for information.

From the Information page, you can find information about the following:

■ Customers

■ Tasks

■ Service requests

■ Install base

■ Inventory and order parts

From the Information page, you can also do the following:

■ Create a service request

■ Create a task

■ Generate a report on tasks 

■ Print out service reports 

5.4.1 Viewing Customer Information 
Before you visit a customer site, you need to know the address and contact 
information. 

You can obtain customer information from the following:

■ The Information page

■ The Calendar page, if a visit to that customer is scheduled (see "Using the 
Calendar Page"  on page 5-6)

■ Using the Quick Find function from the Home, Calendar, and Messaging pages 
(see "Using the Quick Find Function"  on page 5-99)

This section describes how to use the Information page to obtain customer 
information. 
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Steps
Complete the following steps to view information about customers other than those 
who have a visit currently scheduled:

1. Click the Information tab to open the Information page.

2. From the View drop-down list, select Customer. 

3. In the Search field, type the % wildcard character and then click Go.

Customers appear under the Contents heading, on the left side of the page.

If you know the customer for which you want to search, enter all or part of the 
customer name in the Search field. Use the % wildcard to represent one or more 
unknown characters. 

To narrow the search to more specific criteria:

■ From the View drop-down list, select Customer and then click Advanced. 

Additional fields are displayed on which you can search. 

■ Complete one or more fields and then click Search.

Use the % wildcard to represent one or more unknown characters. 

The customer or those matching the specified criteria appear under the 
Contents heading, on the left side of the page.
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4. Click on the desired customer name.

The Information page displays the Customer Details view.
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The Information page (Customer Details view) displays the customer 
information, including contact information and any flexfields that are set up.

5. To view the customer product information for the customer, click on the person 
icon for the desired customer location.

The Information page displays the Customer Products view. This view list all 
the customer products for the customer.
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6. Click Close to exit the Customer Products view. 

7. In the Information page (Customer Details view), click Notes to view existing 
customer notes or to add a new customer note. 

See "Creating and Viewing Notes" on page 5-53 for a complete description of 
this procedure. 

5.4.2 Viewing Install Base Information
Oracle Mobile Field Service/Laptop enables you to view the location and product 
details for a customer product. You are also able to view the configuration of the 
customer product and any additional attributes. Finally, you are able to view and 
add customer product notes.
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Steps
Complete the following steps to view install base information:

1. Click the Information tab to open the Information page. 

2. From the View drop-down list, select Customer Product.

3. In the Search field, type the % wildcard character and then click Go.

Customer products appear under the Contents heading, on the left side of the 
page.

If you know the customer product for which you want to search, enter all or 
part of the customer product name in the Search field. Use the % wildcard to 
represent one or more unknown characters. 

To narrow the search to more specific criteria:

■ From the View drop-down list, select Customer Product and then click 
Advanced. 

Additional fields are displayed on which you can search. 

■ Complete one or more fields and then click Search.

Use the % wildcard to represent one or more unknown characters. 

The desired customer product or those matching the specified criteria 
appear under the Contents heading, on the left side of the page.

4. Click on the desired customer product.

The Information page displays the Installed Base Details view.
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5. Click Configuration.

The Customer Products window opens.
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6. Select the desired service request.

The Customer Products window displays a customer product description.
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7. Click Cancel to return to the Information page (Installed Base Details view).

8. Click Notes to view existing customer product notes or to add a new customer 
product note. 

See "Creating and Viewing Notes" on page 5-53 for a complete description of 
this procedure. 

5.4.3 Working with Service Requests
A service request is created when a customer contacts your organization with a 
problem. Typically, the customer representative analyzes the service request and 
assigns a task or tasks to it. Then the service request, along with all related 
information and tasks, are sent to field service representative. You can view the 
summary details of a service request in the calendar of the Calendar page. See 
"Viewing and Opening Tasks" on page 5-8 for a complete description of this 
procedure. 

This section describes how to create, view, and change a service request. A service 
request contains the following groups of information:

■ General

■ Contact

■ Product

■ Service request

■ Credit card

5.4.3.1 Viewing and Changing Service Request Information
The service request contains practical information, including the problem and likely 
resolution. 

Steps
Complete the following steps to view service request information: 

1. Click the Information tab to open the Information page.

2. From the View drop-down list, select Service Request.

Note: The field service representative can create a service request 
when necessary. 
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3. In the Search field, type the % wildcard character and then click Go.

Service requests appear under the Contents heading, on the left side of the 
page.

If you know the service request for which you want to search, enter all or part 
of the service request name in the Search field. Use the % wildcard to represent 
one or more unknown characters. 

To narrow the search to more specific criteria:

■ From the View drop-down list, select Service Request and then click 
Advanced. 

Additional fields are displayed on which you can search. 

■ Complete one or more fields and then click Search.

Use the % wildcard to represent one or more unknown characters. 

The desired service request or those matching the specified criteria appear 
under the Contents heading, on the left side of the page.

4. Click on the name of the desired service request.

The Information page displays the Service Request Details view for the selected 
service request. 
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5. Under the Product header, you can enter or change information for the 
following:

■ Product field—click the person icon next to this field to specify a new or 
different customer product. The Information page displays the Customer 
Products view.
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Click the desired product code. 

The Information page displays the Service Request Details view, with the 
new product information in the Product and Description fields. Click Close 
to exit the Customer Products view without selecting a customer product.

■ Serial Number field—enter the serial number of the customer product 
specified in the Product field and Description drop-down list.

■ System Item and Installed Base radio buttons—specify the type of customer 
product you specified in the Product field and Description drop-down list.
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6. Under the Service Request header, you can enter or change information for the 
following:

■ Problem drop-down list—make a selection that describes the task problem. 

■ Resolution drop-down list—make a selection that describes the task 
solution.

■ Customer PO Number field—enter the customer purchase order number in 
this field.

■ Flexfields—if these fields are set up, complete them according to your 
needs.

To complete credit card information, see "Viewing and Entering Credit Card 
Information" on page 5-43.

To create a service request note, click Note. See "Creating and Viewing Notes" 
on page 5-53 for a complete description of this procedure.

To create a task, click Create Task. See "Creating a Task" on page 5-50 for a 
complete description of this procedure.

To view the service history, click Service History. See "Viewing Service History" 
on page 5-45 for a complete description of this procedure.

5.4.3.2 Viewing a Service Request Attachment
From the Information page (Service Request Details view), you can open and view 
any attachment associated with a service request. The attachment can vary in type, 
such as a .pdf, .doc, .xls, .gif, etc.

1. Navigate to the Information page (Service Request Details view).

See "Viewing and Changing Service Request Information" on page 5-34 for a 
complete description of this procedure.

2. Tap the attachment icon on the page.

The Attachments page opens.

3. Tap the file that you want to open.

The selected file opens.

Tape Done to return to the Information page (Service Request Details view).
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5.4.3.3 Creating a Service Request
When you are at a customer site, the customer may have an additional request. As 
an additional service, you can create a service request for this customer. 

You can create a service request for each of the following scenarios:

■ Without having any product information 

■ With a system item 

■ With a known customer product (install base)

The service request contains the following detailed information:

■ Request status

■ Type

■ Severity

■ Urgency

■ Problem resolution

■ Customer product involved

■ Installation address

■ A summary of the problem or reason for request

There are three ways you can create a service request for a customer:

■ Based on an existing service request which serves as a template

■ Based on no existing service requests where you have to enter all the necessary 
information

■ Based on the customer product serial number

Steps
To create a service request, complete the following steps:

1. Click the Information tab to open the Information page.

As an alternative, you can click on the task number of the desired service 
request in the Calendar page. This action will take you to the Information page 
with service request information displayed for the desired task.

2. Choose the desired customer for which you want to create a service request.
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See "Viewing Customer Information" on page 5-34 for a complete description of 
this procedure.

3. Click Create Service Request.

The Information page displays the Create Service Request view.

 

To populate all the fields of the Create Service Request view based on an 
existing template, select a template from the Use the following task as template 
drop-down list. After you make this selection, you are able to change any field 
you want in the Create Service Request view.
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4. To change the defaults in the Type, Status, Severity, and Urgency drop-down 
lists, make different selections.

5. Complete the Summary field with the appropriate information.

6. Complete any other fields in the Create Service Request view.

If the product is known, then select the Install Base Product check box and 
specify the product in the Product field.

7. Click Create.

The Information page displays the Service Request Details view. See "Viewing 
and Changing Service Request Information" on page 5-34 for a complete 
description of this page.

5.4.3.4 Viewing Contractual Information
Before starting a task, a field service representative should have as many details 
about the customer and task as possible. Part of these details is the contractual 
information. The field service representative uses this information to determine the 
following:

■ Customer entitlements

■ Contract coverage

Oracle Mobile Field Service/Laptop displays contractual information in a table 
format that you can reference for transaction billing types.

Steps
Complete the following steps to view contractual information:

1. Click the Information tab to open the Information page.

2. Choose the desired service request for which you want contractual information.

See "Viewing and Changing Service Request Information" on page 5-34 for a 
complete description of this procedure.

3. Under the Contents heading, click the "+" button to the left of the desired 
service request. 

Note: The Type, Status, and Severity drop-down lists are 
mandatory along with the Summary field.
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The task(s), field service request report, customer product(s), and contract are 
listed below the service request.

4. Click on the contract.

The Information page displays the Contract Line Details view.

 

The contract number appears in the Contract number field and the type of 
service covered by the contract appears in the Service name field. The service 
description code appears in the Service description field.

5. To change a business process, make a selection from the Business process 
drop-down list.

Under the Transaction Billing Types header is a table that describes each aspect 
of the contract. The contents of this table are determined by the business 
process that you select in the Business process drop-down list.

For example, you could have an Extended Notebook PC Service Program that 
covers eight transaction billing types, each with a maximum amount of 
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$100,000. The percent of the money covered by the service organization varies 
from transaction billing type. For instance, a loaner notebook computer can be 
provided under a Loaner transaction billing type with 10% coverage, so the 
service organization would only be responsible for 10% of the cost. If there was 
a repair estimate, then an Estimate Repair transaction billing type with 100% 
coverage could apply, and the service organization would not be responsible for 
any cost.

5.4.3.5 Viewing and Entering Credit Card Information
Oracle Mobile Field Service/Laptop enables you to record or update the following 
credit card information from the customer point-of-service:

■ Credit card number

■ Expiration date

■ Credit card type

■ Customer name

With this information saved, you do not have to re-enter it. The credit card 
information is encrypted so it is secure. Only the last four digits of the credit card 
number is visible in the application.

When you synchronize with the enterprise system, the credit card information is 
validated. See "Synchronizing with the Enterprise System" on page 5-100 for a 
complete description of this procedure.

Steps
Complete the following steps to view and enter credit card information:

1. Click the Information tab to open the Information page.

2. Choose the desired service request for which you want credit card information.

See "Viewing and Changing Service Request Information" on page 5-34 for a 
complete description of this procedure.

At the bottom of the Information page (Service Request Details view) is the 
credit card information.

Note: The credit card feature is set in a profile. Consult your field 
service administrator on the use of this feature.
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3. To record a customer’s credit card information, complete the desired fields and 
drop-down lists under the Credit Card Details header.

If the customer’s credit card information has already been entered, you can edit 
this information by making changes in the desired field(s) and drop-down 
list(s). The credit card information should be validated to ensure that the credit 
card number provided by the customer is a valid. 

4. Click Save.

To create a service request note, click Note. See "Creating and Viewing Notes" 
on page 5-53 for a complete description of this procedure.
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To create a task, click Create Task. See "Creating a Task" on page 5-50 for a 
complete description of this procedure.

To view service history, click Service History. See "Viewing Service History" on 
page 5-45 for a complete description of this procedure.

5.4.3.6 Viewing Service History
To best service the customer, field service representatives should review the 
customer’s service history prior to making a customer visit. You can request service 
history for either a customer or a customer product. Only tasks and service requests 
that are closed or completed can appear in the service history. The amount of 
service history gathered for a customer is determined in customer setup. Here, the 
administrator determines how many service requests will be used to create the 
service history. For example, the last three service requests may be compiled to 
create the service history.

Service history includes the following:

■ Customer and contact details

■ Product details (item or install base)

■ Service request and task assignment details

■ Reported time, material(s), and expenses for each customer visit

■ Field service representative(s) who visited the customer previously

Steps
Complete the following steps to view service history:

1. Click the Information tab to open the Information page.

2. Choose the desired service request for which you want to view service history.

See "Viewing and Changing Service Request Information" on page 5-34 for a 
complete description of this procedure.

3. Click Service History at the bottom of the Information page (Service Request 
Details view).

The Information page displays the Service History view.
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5.4.4 Working with Tasks
A task is a unit of work within the service request. A task is created during field 
service request screening and qualification in the office, or when working out in the 
field. A task is related to a specific problem that needs to be resolved through a 
service request.

Update task status in order to keep your schedule up to date and to inform the 
dispatcher on the progress of your schedule. See "Viewing and Opening Tasks" on 
page 5-8 for a complete description of this procedure.

Oracle Mobile Field Service/Laptop enables you to view and change existing tasks 
and to create new ones.
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5.4.4.1 Viewing and Changing Task Information
For a task assigned to you, you need to retrieve information such as what is the 
problem and what parts and materials are needed. 

You can request task data from the following:

■ The Information page

■ Your daily calendar, if a visit to that customer is scheduled (see "Using the 
Calendar Page"  on page 5-6)

■ Using the Quick Find function from the Home, Calendar, and Messaging pages 
(see "Using the Quick Find Function"  on page 5-99)

This section describes how to view and change task information. 

Steps
Complete the following steps to see information about any task, not just those that 
are scheduled:

1. Click the Information tab to open the Information page.

2. From the View drop-down list, select Task.

3. In the Search field, type the % wildcard character and then click Go.

For each customer, the service requests and tasks appear under the Contents 
heading, on the left side of the page.

If you know the task for which you want to search, enter all or part of the task 
name in the Search field. Use the % wildcard to represent one or more unknown 
characters. 

To narrow the search to more specific criteria:

■ From the View drop-down list, select Task and then click Advanced. 

Additional fields are displayed on which you can search. 

■ Complete one or more fields and then click Search.

Use the % wildcard to represent one or more unknown characters. 

The desired task or those matching the specified criteria appear under the 
Contents heading.

4. Click on the desired task to view the task details.
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The Information page displays the Task Details view, which contains 
information about the selected task.

 

If the task was escalated at the enterprise system, then the Escalated check box 
is selected.

5. To order parts for the current task, click the Order Parts link.

The Information page (Search Results view) opens. For a complete description 
of this page, see "Ordering a Part" on page 5-85.

6. To access Quick Debrief, click the Quick Debrief link.
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See "Using Quick Debrief" on page 5-12 for a complete description of this 
procedure.

7. In the Information page (Task Details view), under the Task header, ensure that 
the values in the fields and drop-down lists are correct.

The Planned Start Date and Planned End Date fields show the task 
start-and-end period according to the contract agreement. See "Viewing 
Contractual Information" on page 5-41 for complete contract details.

Depending on the business scenario your system administrator has chosen, you 
can enter the time that the visit is likely to take place in the Scheduled Start 
Date and Scheduled End Date fields. The actual start and end times for a task 
are listed in the time report. See "Creating and Deleting a Time Report Item" on 
page 5-57 for the actual time reporting.

Depending on the business scenario your system administrator has 
implemented, you may or may not be able to change the value in the Planned 
Effort field.

If flexfields are set up, change or complete them according to your needs.

8. Under the Task Assignment header, ensure that the selection in the Assignment 
Status drop-down list is correct.

9. Click Notes to view any existing task notes or to add a new task note. 

See "Creating and Viewing Notes" on page 5-53 for a complete description of 
this procedure. 

10. To save any changes to the task, click Update. 

Click Restore to return the original values to the Task Details view.

Note: The fields and drop-down lists under the Task header are 
enabled as long as Cancelled or Completed is not specified in 
the Assignment Status drop-down list.

Note: The fields and drop-down lists under the Task Assignment 
header are enabled as long as Cancelled or Completed is not 
specified in the Assignment Status drop-down list.
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5.4.4.2 Viewing a Task Attachment
From the Information page (Task Details view), you can open and view any 
attachment associated with a service request. The attachment can vary in type, such 
as a .pdf, .doc, .xls, .gif, etc.

1. Navigate to the Information page (Task Details view).

See "Viewing and Changing Task Information" on page 5-47 for a complete 
description of this procedure.

2. Tap the attachment icon on the page.

The Attachments page opens.

3. Tap the file that you want to open.

The selected file opens.

Tape Done to return to the Information page (Task Details view).

5.4.4.3 Creating a Task
There may be times when you need to create a new or additional task for a service 
request. For example, if you cannot complete a task or need support from a fellow 
field service representative, then you should create an additional task.

There are two ways you can create a task:

■ Based on an existing task which serves as a template

■ Based on no existing task where you have to complete all the desired fields

Prerequisites
A service request must already exist.

Steps
Complete the following steps to create a task:

1. Click the Information tab to open the Information page.

2. Choose the customer for which you want to create a task.

See "Viewing Customer Information" on page 5-34 for a complete description of 
this procedure.

3. Under the Contents heading, click the "+" button to the left of a customer name 
to view service requests for the customer.
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4. Click the service request for which you want to create a task.

The Information page displays the Service Request Details view.

 

■ To specify the cause of the service request, select an item from the Problem 
drop-down list under the Service Request header.

■ To specify the solution for the service request, select an item from the 
Resolution drop-down list under the Service Request header.

■ Click Save to save the update.
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5. Click Create Task at the bottom of the Service Request Details view.

The Information page displays the Create Task view.

 

Note: To populate all the fields of the Create Task view based on 
an existing template, select a template from the Use the following 
task as template drop-down list. After you make this selection, you 
are still able to change any fields that you want in the Create Task 
view.
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6. Select the appropriate information from the Type and Status drop-down lists.

7. Enter the task name in the Name field.

8. Complete or modify any other fields in this page.

9. Click Create.

The Information page displays the Task Details view for the new task. The new 
task also appears under the service request, on the left side of the page. See 
"Viewing and Changing Task Information" on page 5-47 for a complete 
description of this page.

5.4.5 Creating and Viewing Notes 
You can create and view notes for the following:

■ Customer

■ Customer product

■ Service request

■ Task 

For example, you may note that a power supply has to be replaced by a refurbished 
one.

A note includes the following:

■ Note text

■ Current date 

■ Note type

■ Note status

Note: For a task to be automatically assigned to you, it should 
have the "Assignment" attribute and the task type should have the 
Dispatch rule. You can immediately work on a task with this 
criteria, which includes entering debrief reports.

Note: The Type and Status drop-down lists are mandatory along 
with the Name field.
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Complete the following steps to create and view a note:

1. Open the appropriate page.

■ To create and view a service request note, open the Information page 
(Service Request Details view).

See "Viewing and Changing Service Request Information" on page 5-34 for 
a complete description of this procedure.

■ To create and view a task note, open the Information page (Task Details 
view).

See "Viewing and Changing Task Information" on page 5-47 for a complete 
description of this procedure.

■ To create and view a customer note, open the Information page (Customer 
Details view).

See "Viewing Customer Information" on page 5-26 for a complete 
description of this procedure.

■ To create and view a customer product note, open the Information page 
(Installed Base Details view).

See "Viewing Install Base Information" on page 5-30 for a complete 
description of this procedure.

2. To view any existing notes or to add a new note, click Notes. 

A window opens, divide into a Notes section and a Note details section. The 
Notes section lists all the notes for the entity in question. The Note details 
section shows the date of note creation and the note author.
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When you click on a note listed in the Notes section, the note text appears in the 
Note field of the Note details section. 

3. To create a new note, click Add note. 

A new Notes window opens.
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4. From the Note type drop-down list, select the note type.

5. From the Note status drop-down list, select the not status.

6. In the Note field, enter the note text. 

7. Click Save.

Oracle Mobile Field Service/Laptop opens a new, blank Notes window where 
you can add another note.

The next time you synchronize with the enterprise system, the saved note is 
added.

8. Add another note as described above or click Close to close the Notes window.

Note: For a note to appear on a customer invoice, the note type 
must be "Invoice".
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5.4.6 Debrief Reporting
After you complete a task, you can report the following information:

■ Time Describes how much time a task took to complete.

■ Materials Describes what materials were involved in the completion of a task. 
This includes both replacement and recovered parts. This 
information is used by the home office to replenish part inventories.

■ Expenses Describes the expenses required to complete a task.

Once field service representatives record any or all of the above information, they 
can then upload this information to the enterprise system by synchronizing Oracle 
Mobile Field Service/Laptop. With this information now in the enterprise system, 
the home office can review and update the customer install base, spare parts 
inventory, and billing information.

5.4.6.1 Creating and Deleting a Time Report Item
When you have completed a task, enter the amount of time the task took to 
complete along with other related information. 

For a locally created time report item that has not been synchronized, Oracle Mobile 
Field Service/Laptop enables you to delete this report item from the time report.

Steps
Complete the following steps to create a time report item:

1. Click the Information tab to open the Information page.

2. Choose the desired task for which you want to create a time report.

See "Viewing and Changing Task Information" on page 5-47 for a complete 
description of this procedure.

3. Under the Contents heading, click the "+" button to the left of the desired task.

Note: The actual times are determined when the field service 
representative sets a task assignment status to "Working" or 
"Closed." See "Viewing and Changing Task Information" on 
page 5-47 for a complete description of this procedure.

Oracle Mobile Field Service/Laptop uses the labor times that you 
enter to calculate the actual times. If there are no reported labor 
times, the application uses the time status change time stamp. 
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All the reports for the task are listed, including the time report.

4. Select Time Reporting. 

The Information page opens the Time Reporting view. This view contains 
default values for the Business Process, Labor Type, Labor Item, and UOM 
drop-down lists along with the Start Time and End Time fields.

Note: The Business Process, Labor Type, and Labor Item 
drop-down lists are mandatory. To specify the length of the task, 
either the Start Time and End Time fields are mandatory or the 
Duration field and UOM drop-down list are mandatory. Specify the 
length of time using one of these pairs, but not both.
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5. To change the default business process, Customer Support, make the 
appropriate selection from the Business Process drop-down list. 

6. To change the default service activity code, make the appropriate selection from 
the Service Activity Code drop-down list.

7. To change the default labor item, make the appropriate selection from the Labor 
Item drop-down list.

8. To change the service date, make the appropriate selection from the Service 
Date drop-down list.

In the following steps, specify the amount of labor time used to complete the task. 
Complete either steps 9 and 10 or steps 11 and 12, according to your business 
process.

9. Specify a task start time:

■ Click the calendar button near the Start Time field and then select the task 
start date.

For a complete description of this procedure, see "Viewing a Past or Future 
Calendar" on page 5-11.

■ From the hour and minutes drop-down lists, select the time you started a 
task.

The hour drop-down list provides values for the 24-hour clock format. If 
you are selecting a time after 12:00 P.M., add twelve to the hour to get the 
24-hour clock equivalent. For example, 4:30 P.M. would be entered as 16 
hours and 30 minutes.

10. Specify a task end time:

■ Click the calendar button near the End Time field and then select the task 
end date.

For a complete description of this procedure, see "Viewing a Past or Future 
Calendar" on page 5-11.

■ From the hour and minutes drop-down lists, select the time you ended a 
task.

Again, the hour drop-down list provides values for the 24-hour clock 
format.

11. In the Duration field, enter the length of time the task took to complete.
Using Oracle Mobile Field Service/Laptop 5-59



Using the Information Page
12. From the UOM drop-down list, select the unit of time that describes the value in 
the Duration field.

13. From the Labor Reason Code drop-down list, select the reason code that best 
describes the time reporting.

14. For any flexfields, complete these according to your needs.

15. Click Add.

The time report item is saved to your laptop computer. In the Summary of 
Reported Labor table, the new time report item is now listed.

To delete the newly created time report item, select the time report item and 
then click Delete selected.

5.4.6.2 Creating and Deleting a Material Report Item
After you complete a task, you can record what materials were used in the 
completion of the task. The home office uses this information to replenish or replace 
needed materials, maintain the customers install base, and possibly invoice the 
customer for the materials used.

Initially, one item is associated with a service request. This can be an item from a 
customer's install base or an item from an inventory. One or more tasks are created 
for this service request and you can create a material report for each task. If multiple 
field service representatives are assigned to a task, then you can create multiple 
material reports for a task. You can also report several transactions in a material 
report. For each material transaction, a separate line is created in the report.

For a locally created material report item that has not been synchronized, Oracle 
Mobile Field Service/Laptop enables you to delete this report item from the 
material report.

Steps
Complete the following steps to create a material report item:

1. Click the Information tab to open the Information page.

2. Choose the desired task for which you want to create a material report.

See "Viewing and Changing Task Information" on page 5-47 for a complete 
description of this procedure.

3. Under the Contents heading, click the "+" button to the left of the desired task.

All the reports for the task are listed, including the material report.
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4. Select Material reporting. 

The Information page displays the Material Reporting view. There are two 
versions of this view: one for recovered parts and the other for used parts. In 
both versions, there are default values for the Business Process and Transaction 
Type drop-down lists.

5. To change the default business process, Customer Support, make the 
appropriate selection from the Business Process drop-down list. 
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The business process selection determines the selection in the Transaction Type 
drop-down list. The selection in this drop-down list determines whether fields 
and drop-down lists for a used or recovered part appear in the Material 
Reporting view. 

6. To change the default transaction type, make the appropriate selection from the 
Transaction Type drop-down list. 

7. Click Find to locate and select the part.

If you have enough information to describe the part, you can complete the 
mandatory fields and any other fields and then click Add. (Mandatory fields 
are denoted with an asterisk [*])

After you click Find, either the Information page displays the Search Materials 
view or the Customer Products window opens. If you are searching for a 
recovered install-base part, then the Customer Products window opens.

Selecting a Recovered Install Base Part

■ Select the desired service request.

The Customer Products window displays a recovered install base part.
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■ Click OK.

The recovered install base part appears in the Information page (Material 
Reporting view) under the Recovered Part header.
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■ Proceed to step 8.
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Selecting a Part that is Not Recovered and Install Base

■ Click Find without completing any fields or the drop-down list.

The Search Results section appears in the Search Materials view of the 
Information page. This section displays all the possible parts for the task.
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If you know information about the desired part and would like to limit 
your search:

– Complete any of the fields and the drop-down list in the Information 
page (Search Materials view).

These fields are self-explanatory.

– Click Find.

The Information page (Search Materials view) displays the part(s) for 
the task under the Search Results header.
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■ Under the Search Results header, select the desired part.

The Search Materials view closes and the selected part appears in the 
Material Reporting view under the Used Part header or Recovered Part 
header, depending on the type of material report item you are reporting.

8. In the Serial Number field of the Information page (Material Reporting view), 
enter an optional serial number for the part.

Add the serial number for a part that is serial-number based and has no serial 
number allocated to the item instance.
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9. Click Add to add the selected material report item to the material report.

The material report item is saved to your laptop computer. The Information 
page (Material Reporting view) displays the part, along with a detailed 
description in the Summary of Reported Materials table. In this case, Item 
AS18947 is saved and added to the Summary of Reported Materials table.

To remove the selected part description from the Material Reporting view, click 
Clear instead of Add.
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To delete the newly created material report item, select the material report item 
from the Summary of Reported Materials table and then click Delete selected.

5.4.6.3 Creating and Deleting an Expense Report Item
After you complete a task, you can then enter information that describes the 
expenses associated with that task. Expenses may include such things as a meal and 
driving costs.

For a locally created expense report item that has not been synchronized, Oracle 
Mobile Field Service/Laptop enables you to delete this report item from the 
expense report.

Steps
Complete the following steps to create an expense report item:

1. Click the Information tab to open the Information page.

2. Choose the desired task for which you want to create a expense report item.

See "Viewing and Changing Task Information" on page 5-47 for a complete 
description of this procedure.

3. Under the Contents heading, click the "+" button to the left of the desired task.

All the reports for the task are listed, including the expense report.

4. Click Expense reporting. 

The Information page displays the Expense Reporting view. This view contains 
default values for the Business Process, Expense Type, Expense Item, UOM, and 
Currency drop-down lists.
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5. To change the default business process, Customer Support, make the 
appropriate selection from the Business Process drop-down list. 

Note: The Business Process, Expense Type, and Expense Item 
drop-down lists are mandatory. To specify the expense of the task, 
either the Quantity filed and UOM drop-down list are mandatory or 
the Cost field and Currency drop-down list are mandatory. Specify 
the expense using one of these pairs, but not both.
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6. To change the default expense type, make the appropriate selection from the 
Expense Type drop-down list.

7. To change the default expense item, make the appropriate selection from the 
Expense Item drop-down list.

8. Specify the cost and currency that describes the expense. 

The Quantity field and UOM drop-down list are used together while the Cost 
field and Currency drop-down list are paired together. In your description, 
complete only one of these field-and-drop-down list combinations.

■ In the Cost field, enter the cost of completing the task. In the Currency 
drop-down list, ensure that the default currency is correct. If necessary, 
change it to the correct currency. 

■ Complete the Quantity field and UOM drop-down list if the pricing amount 
is unknown.

9. Click Add to add the selected expense report item to the expense report.

The expense report item is saved to your laptop computer. The Information 
page (Expense Reporting view) displays the part, along with a detailed 
description in the Summary of Reported Expenses table.

Click Clear to remove the selected part description from the Expense Reporting 
view.
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To delete the newly created expense report item, select the expense report item 
and then click Delete selected.

5.4.6.4 Printing the Field Service Request Report
You can print out a document that summarizes all the information about time, 
material, and expenses for a service request. This is useful for leaving at the 
customer site, or for getting a signature. 
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Steps
Complete the following steps to print the Field Service Request Report. 

1. Click the Information tab to open the Information page.

2. Choose the desired service request for which you want to print a report.

See "Viewing and Changing Service Request Information" on page 5-34 for a 
complete description of this procedure.

3. Under the Contents heading, click the "+" button to the left of the service 
request for which you want to print a report. 

The field service request report, the customer product (install base), and task(s) 
appear under the selected service request.

4. Click Field Service Request Report. 

The summary appears, showing the Reported time, Reported material, and 
Reported expenses. The current date and space for a signature appear at the 
bottom of the report. 
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5. Click Print in your browser window. 

5.4.6.5 Printing the Field Service Task Report
You can print a report that summarizes all the information about time, material, and 
expenses for a task. This is useful for leaving at the customer site, or for getting a 
signature. 
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The time, material, and expenses report information that you entered for a task is 
listed in the Field Service Task Report under descriptive headers. This information 
is limited to what you recorded for a particular task.

Steps
Complete the following steps to print the Field Service Task Report: 

1. Click the Information tab to open the Information page.

2. Choose the desired task for which you want to print a report.

See "Viewing and Changing Task Information" on page 5-47 for a complete 
description of this procedure.

3. Under the Contents heading, click the "+" button to the left of the desired task to 
list all the task reports, including the Field Service Task Report.

4. Click Field Service Task Report. 

The summary appears, showing the reported time, material, and expenses. The 
customer and task details are also shown. The customer name, current date, and 
space for a signature appear at the bottom of the Field Service Task Report for 
customer sign off. 
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5. Click Print in your browser window. 

5.4.7 Setting Counters and Counter Properties
You can log a service request for a customer product that contains a counter. A 
counter helps a service representative determine how much work was done before a 
customer product was serviced. A copier having a number-of-copies counter is an 
example of this.
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On the Information page, there can be multiple customer product counters, each 
with multiple readings. From these multiple readings, you can learn the service 
history of the customer product. You can also create new readings for a customer 
product counter. You can reset a reading as well as make miscellaneous readings. A 
miscellaneous reading can be a value used for testing a customer product. For 
example, an engineer who is fixing a copier may make ten test copies after 
completing the service. The copy counter value increases by ten, but he does not 
want the customer to pay for the test copies. Therefore, the field service 
representative can state a miscellaneous reading of ten.

Finally, you can enter counter properties. Counter properties describe something 
about the customer product counter.

Steps
Complete the following steps to enter a counter reading and set the counter 
properties:

1. Click the Information tab to open the Information page.

2. Choose the desired customer product for which you want to enter a counter 
reading and set the counter properties.

See "Viewing Install Base Information" on page 5-30 for a complete description 
of this procedure.

3. Under the Contents header, click the "+" button to the left of the desired 
customer product to view the counter.

4. Click on the customer product counter.

The counter readings for the selected customer product appear in the Counter 
Readings view of the Information page. These counter readings are for specific 
dates.

Note: Only customer products with the "+" button contain a 
customer product counter.
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5. Click New Reading.

The Information page displays the Counter Reading view.
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6. Enter the appropriate information in the Date and Reading fields.

7. Complete or change any other fields in this page.

■ Make the appropriate selection from the Misc. Reading Type drop-down list 
and complete the Misc. Reading field to make miscellaneous readings.

■ Select the Reset Flag check box and then complete the Pre-reset Last 
Reading and Post-reset First Reading fields to reset the counter.

Note: The Date and Reading fields are mandatory. The date is the 
date you take a reading and the reading is the counter value that 
you want to record.
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Pre-reset is the last counter value before the reset of the counter. Post-reset 
is the first new reading after the reset.

8. Complete the property fields for your customer product.

9. Click Save.

Oracle Mobile Field Service/Laptop returns to the Counter Readings view of 
the Information page where the new counter reading is listed.

5.4.8 Spares Management
Oracle Mobile Field Service/Laptop enables you to manage the parts inventory that 
you can use in the repair or replacement of parts for a service request. The parts in 
inventory are known as spares and their management is known as spares 
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management. Spares management is a critical process in field service. Spares are not 
only stored in the warehouse, but also inside the truck of a field service 
representative. It is therefore crucial to know where spares are located and how 
soon a field service representative can have them. In spares management, Oracle 
Mobile Field Service/Laptop allows you to do the following:

■ Oversee the inventory stocked in the truck

■ Manage spare parts

■ Order and transfer parts

■ Oversee defective parts that need to be sent back

■ Maintain stock levels and install base

■ Stay current with business information

■ Print out service reports (time, material, expenses) for a customer

5.4.8.1 Ordering a Part
Oracle Mobile Field Service/Laptop enables you to order parts from inventories 
assigned to you and those that are not assigned to you (sub-inventories). The latter 
case requires you to do a advanced search where you supply specific information 
about the desired part.

Prerequisites
■ Desired part must already exist, either in the vehicle or at some other location 

(only applicable if Spares Management is being used). See the Oracle Mobile 
Field Service Implementation and Administration Guide for Field Service/Laptop for 
details about Spares Management.

■ Desired part must be defined as "orderable".

Steps
Complete the following steps to order a part:

1. Click the Information tab to open the Information page. 

2. From the View drop-down list, select Inventory.

3. In the Search field, type the % wildcard character and then click Go.

Inventories appear under the Contents heading, on the left side of the page.
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If you know the inventory for which you want to search, enter all or part of the 
inventory name in the Search field. Use the % wildcard to represent one or more 
unknown characters. 

To narrow the search to more specific criteria:

■ From the View drop-down list, select Inventory and then click Advanced. 

Additional fields are displayed on which you can search. 

■ Complete one or more fields and then click Search.

Use the % wildcard to represent one or more unknown characters. 

The desired inventory or those matching the specified criteria appear under 
the Contents heading, on the left side of the page.

4. Under the Contents heading, click the "+" button to the left of the desired 
inventory to view the inventory items.

5. Click on an inventory.

The inventory items for the selected inventory appear in the Search Results 
view of the Information page.

Note: You can specify an inventory not assigned to you if it 
contains the desired part. In this case, continue with the following 
steps to narrow the search.
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6. In the Select column, click the button of the desired part and then click Order.

The Information page displays the Order an Item view.

Click Transfer to transfer a part. See "Transferring a Part" on page 5-89 for a 
complete description of this procedure.
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7. Complete the Quantity field with the appropriate information.

8. Select the appropriate information from the UOM (Unit Of Measure), 
Subinventory, and Shipment location drop-down lists.

9. Complete the Need by date field to specify a part delivery date.

Note: The Quantity field along with the UOM, Subinventory, and 
Shipment location drop-down lists are mandatory. The shipment 
location is where you want the part delivered.
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10. Click Save to place the order.

Click Restore to cancel the order.

5.4.8.2 Transferring a Part
This section describes how to transfer a part from one sub-inventory to another. 

Steps
Complete the following steps to transfer a part from a sub-inventory:

1. Click the Information tab to open the Information page.

2. Choose the desired inventory from which you want to transfer a part.

See "Ordering a Part" on page 5-85 for a complete description of this procedure.

3. From the Select column in the Information page (Search Results view), click the 
button of the desired part and then click Transfer.

The Information page displays the Transfer Parts view.
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Click Order to order a part. See "Ordering a Part" on page 5-85 for a complete 
description of this procedure.

4. From the Subinventory drop-down list, select the subinventory from which you 
want to transfer a part.

5. From the To subinventory drop-down list, select the destination subinventory 
where you want transfer a part.

6. From the Quantity field, specify the amount of parts you want to transfer.
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7. From the UOM drop-down list, select the unit of measure for the amount.

8. From the Reason drop-down list, select the reason for the transfer.

9. In the Reference field, specify the transfer reference.

10. Click Add.

A summary of the part transfer appears in the Transfer Lines table.

Click Cancel to exit without saving.

5.4.8.3 Viewing Part Order Details
Once a part is ordered, you can view the details regarding this part.

Prerequisites
A part must be ordered to view the order details.

Steps
Complete the following steps to view part order details:

1. Click the Information tab to open the Information page.

2. From the View drop-down list, select Order.

3. In the Search field, type the % wildcard character and then click Go.

Item descriptions appear under the Contents heading, on the left side of the 
page. These descriptions include the item number, status, and requirement 
number

If you know the item for which you want to search, enter all or part of the item 
name in the Search field. Use the % wildcard to represent one or more unknown 
characters. 

To narrow the search to more specific criteria:

■ From the View drop-down list, select Order and then click Advanced. 

Additional fields are displayed on which you can search. 

■ Complete one or more fields and then click Search.

Note: The Subinventory, To subinventory, Quantity, and UOM 
drop down lists are mandatory.
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Use the % wildcard to represent one or more unknown characters. 

The desired item or those matching the specified criteria appear under the 
Contents heading, on the left side of the page.

4. Click on the name of the desired item.

A detailed description for the selected item appears in the Item Order Details 
view of the Information page.
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5.5 Using the Messaging Page 
Oracle Mobile Field Service/Laptop enables you to send and receive messages to 
other people within your organization. This messaging function facilitates 
communication among field service employees. It can be set up to send messages 
among all Field Service users, or among the members of one team. 

You can use this page to send or receive messages. You can use this to ask for 
support or additional information.

5.5.1 Viewing Received Messages
After you synchronize with the enterprise system, you can check to see if you have 
received any messages. 

Steps
Complete the following steps to read messages that you have received, and to 
delete messages that you have read:

1. Click the Messaging tab to open the Messaging page.

2. Ensure that the Inbox subtab is selected. 

3. To read a message, click on the message subject in the Subject column. 

A window opens showing the complete message. A blue icon next to the 
Subject indicates that the message has an attachment. 
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4. To reply to a message, click Reply. 

A new message with a blank Message field appears. The subject and recipient 
fields are already completed. 

5. To delete a message, select the check box to the left of the desired message and 
then click Delete selected. 

The check box is in the Select column.
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5.5.2 Writing and Sending New Messages
When you need information from one of the other members of the field service 
organization, you can ask for it by sending a message. 

Steps
Complete the following steps to write and send messages to others people in your 
field service organization: 

1. Click the Messaging tab to open the Messaging page.

2. Click the New subtab. 
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3. From the To drop-down list, select the recipient’s name. 

4. In the Subject field, enter a title or brief summary of the message. 

5. Change the information in the Priority drop-down list, if necessary. 

6. In the Message field, enter the text of the message. 

Messages can be up to 255 characters long. 

7. Click Send to send the message. 

5.5.3 Viewing Sent Messages
In the Messaging page, you can ensure that a message you wrote has been sent to 
the intended person(s) in your field service organization.

Steps
Complete the following steps to view the messages you have sent:

1. Click the Messaging tab to open the Messaging page.

2. Click the Outbox subtab. 

The messages you have recently sent appear. 
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3. Click on the recipient’s name in the To column to see the user IDs of the other 
mobile users. 

4. Choose the recipient’s name.

5. Click on the message in the Subject column to see the text of the message that 
you sent. 
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5.6 Using the Home Page
The Home page is updated with the number of task at a particular status each time 
you synchronize with the enterprise system. 

Steps
Complete the following to access the Home page:

■ Click the Home tab to open the Home page.

In this page, you can view the Tasks Summary table. This table lists how many 
tasks are at a particular status.
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5.7 Using the Quick Find Function
You can perform a quick find from the Home, Calendar, and Messaging pages. A 
quick find allows you to locate any of the following:

■ Customer

■ Customer product

■ Inventory

■ Item

■ Order

■ Personal task

■ Service request

■ Task

Steps
To do a quick find, complete the following steps from either the Home, Calendar, or 
Messaging pages:

1. From the Quick Find drop-down list, select the type of information for which 
you want to search. 

2. In the search field, enter the word or numbers for which to search.

Use the % wildcard to represent one or more unknown characters. 

3. Click Go.

The Information page opens and the search results are displayed in an outline 
on the left side of the page.

To narrow the search to more specific criteria:

■ From the Quick Find drop-down list, select a value and then click 
Advanced Search. 

Additional fields appear that correspond to the type of information you 
entered in the Quick Find drop-down list. 

■ Complete one or more fields and then click Search. 

Use the % wildcard to represent one or more unknown characters.
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5.8 Global Button Functionality
The global buttons are located in the upper right corner of each page in the Oracle 
Mobile Field Service/Laptop application. 

5.8.1 Preferences Button
Click the Preferences button to view your profile settings. Profile options are set by 
the system administrator at the home office. 

5.8.2 Synchronizing with the Enterprise System
In order to receive new data assigned to you, such as new tasks and service 
requests, you need to synchronize with the enterprise system. Likewise, to send the 
changes that you have made, such as creating debrief lines and updating task 
statuses to the enterprise system, you need to synchronize with the enterprise 
system.

Steps
Complete the following steps to synchronize Oracle Mobile Field Service/Laptop 
information with the enterprise system:

1. Establish a telephone / internet connection for your laptop computer. 

2. Click the Synchronize button in the upper right corner of the page. 

The Oracle9i Lite Client Synchronization page opens.
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The information on your laptop computer is synchronized with the enterprise 
system. Synchronizing your data can take a few minutes; therefore, do not abort 
this process. If the synchronization process fails, contact your system 
administrator. 

After synchronization completes, the browser displays the Oracle Mobile Field 
Service/Laptop Calendar page.
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5.8.3 Obtaining Online Help
The online help for the Oracle Mobile Field Service/Laptop application is an online 
version of the Oracle Mobile Field Service User Guide.

Steps
Complete the following steps to obtain online help:

1. Click the Help button in the upper right corner of any page. 

Oracle Mobile Field Service/Laptop displays an online version of the Oracle 
Mobile Field Service User Guide.

2. Navigate through the hyperlinks to find the desired information.
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5.8.4 Logging Out
When you have finished working in Oracle Mobile Field Service/Laptop, log out of 
the application. 

Prerequisites
Save all data and be ready to exit the application.

Steps
Do the following to log out of Oracle Mobile Field Service/Laptop:

■ Click the Logout button in the upper right corner of any page. 

Oracle Mobile Field Service/Laptop checks that all data has been correctly 
saved and then closes. The application returns you to the login page. 
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Scheduling and Completing Tasks

The administrator can organize the Oracle Mobile Field Service application in 
several different ways, depending on how much control a field service 
representative is given over his schedule. This appendix describes several different 
levels of control for the field service representative.

A.1 Conform to the Schedule
The field service representative can only work on one job at a time, and is given a 
schedule that the dispatcher plans. Take, for example, the following tasks:

■ task 1: 8:00 Installation at Customer A

■ task 2: 9:00 Repair on-site at Customer B

■ task 3: 10:00 Installation at Customer C

The field service representative first needs to finish task 1 before going on to task 2. 
He needs to follow the pre-defined order of the dispatcher. The field service 
representative cannot reschedule a task, but he can reject a task. 

This setup gives the dispatcher control over the daily schedule of the field service 
representative. The dispatcher sets up the tasks, including what time and where the 
field service representative is to be at all times.
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A.2 Order of Task Completion
If you send more than one field service representative to perform a task, make sure 
that you schedule only one task assignment at a time, because multiple task 
assignments can lead to conflicts. For example, suppose you have a task that 
requires three field service representatives. You set up the task and then you send it 
to the task lists of all three representatives. It now appears on their task list. 
However, if one of your field service representatives changes the time for his task, 
that would affect the task list of the other two representatives. To avoid this, you 
must create three tasks, one for each representative.

The service representative can complete his scheduled tasks under different 
scenarios.

Scenario 1: Complete Scheduled Tasks in Pre-determined Order
In this scenario, the field service representative works on one job at a time and 
conforms to the dispatched schedule.

Scenario 2: Complete One Scheduled Task at a Time in Any Order
In this scenario, the field service representative works on a single job at a time and 
does not conform to the dispatched schedule.

Scenario 3: Complete Multiple Scheduled Tasks in Any Order
In this scenario, the field service representative works on multiple jobs at a time and 
does not conform to the dispatched schedule.

Scenario 2 and Scenario 3 gives the field service representative control over his day. 
The dispatcher sends the tasks and locations to the field service representative, and 
the service representative then decides when to perform each task. This scenario 
works well in an environment where each task requires only one field service 
representative. For example, if a field service representative has a dental 
appointment, he can arrange the time he wants to be at the customer site near his 
dentist. The field service representative is expected to complete all the tasks on the 
day they were assigned. If he is unable to complete a scheduled task, he can reject it 
and then the dispatcher will re-schedule the task for the next day.
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A.3 General Operating Rules
This section describes some general operating rules of Oracle Mobile Field Service 
that may not be obvious. Some of these rules are based on the scenarios found in 
"Order of Task Completion" on page A-2.

The following are the general rules for working in Oracle Mobile Field Service:

■ You can add notes, but notes are not updatable once completed.

■ You can update and create debrief items for a task that does not have the status 
of completed or for a task that you have not yet synchronized with the 
enterprise system. (Synchronized debrief lines cannot be updated.)

See "Understanding the Task List Screen" on page 3-6 for a complete description 
of the task status flags.

■ You cannot delete report items after they are synchronized.

■ If several working tasks are synchronized in Scenario 1 or Scenario 2, you can 
work on both tasks until they are closed. Then you must handle your tasks in 
compliance to the profile setting.

■ Scenario 1 will be the default when there is no profile set.

■ Once you synchronize, a signature cannot be updated.

■ Once a you complete or close a task, you cannot add counters. 

■ Counters are not updatable.
Scheduling and Completing Tasks A-3



General Operating Rules
A-4 Oracle Mobile Field Service User Guide



Index

A
Accepted task status, 3-14, 5-10
ActiveSync 3.6, 2-2
All Task for SR screen shot, 3-29
Amount field, 3-60
ARM, 2-2
Assigned task status, 5-10
Assignment Status drop-down list, 5-49
attachment global icon, 3-5

B
Business Process drop-down list (Information 

screen, Expense Reporting), 5-17, 5-70
Business Process drop-down list (Information 

screen, Time Reporting), 5-59, 5-61
buttons

Clear, 3-64
Counter, 3-69
Credit, 3-65, 3-67
Delete, 3-89
Delete (Labor Line screen), 3-45
Delete selected, 5-60, 5-69, 5-72
Signed, 3-63
Today, 3-9

C
calendar bar screen shot, 3-10
Calendar page

Create Personal Task view, 5-25
Customer column, 5-9
Daily View of the Calendar page, 5-25

page shot, 5-6
Product column, 5-9
Request column, 5-9
Scheduled column, 5-9
Status column, 5-9
Task Name column, 5-9
Task Number column, 5-9
Travel Time column, 5-9

Calendar tab, 5-6, 5-8, 5-11, 5-25
calendar window, 5-11
Cancelled task status, 3-14, 5-10
Change, 3-92
Change check box, 2-7, 3-92
check boxes

Change, 2-7, 3-92
Escalated, 5-48
Force Refresh, 2-7, 3-92
Install Base Product, 5-41
New Mail, 3-89
Reset Flag, 5-83
Save Password, 2-7, 3-92
Secure, 3-92
Use Proxy, 2-7, 3-92

Clear button, 3-64
Closed status, 5-57
Closed task status, 3-14, 5-10
Completed task status, 3-14, 5-10
Computer Telephone Integration (CTI), 1-3
Contract screen

read-only fields, 3-28
Contract screen shot, 3-27
Counter button, 3-69
Create Parts Order drop-down list selection, 3-19
Create Parts Requirement Goto menu 
Index-1



selection, 3-16, 3-73
Create SR screen shot, 3-32
Create Task screen shot, 3-18
Create Task view (Information page), 5-52
Credit button, 3-65, 3-67
Credit Card Details header, 5-44
CTI, 1-3
Currency drop-down list, 3-60, 5-18, 5-71
Cust PO field, 3-24
Customer column (Calendar page), 5-9
Customer field, 3-12
customer flexfields, 3-24, 3-82, 3-83
Customer Notes screen shot, 3-36
Customer PO field, 3-34
Customer PO Number field, 5-38
Customer Product screen

read-only fields, 3-84
Customer Product selection, 5-31
Customer selection, 5-27
customer setup, 5-45

D
date drop-down list (Engineers Task List), 3-8
Debrief screen shot, 3-31, 3-40, 3-44
Delete button (Labor Line screen), 3-45
Delete buttons, 3-89
Delete selected button, 5-60, 5-69, 5-72
Description field, 3-28
desktop PC, 2-1
drop-down lists

Assignment Status, 5-49
Business Process drop-down list (Information 

screen, Expense Reporting), 5-17, 5-70
Business Process drop-down list (Information 

screen, Time Reporting), 5-59, 5-61
Currency, 3-60, 5-18, 5-71
End, 3-19
Exit, 3-93
Expense, 5-18, 5-71
Item, 3-49
Misc. Reading Type, 5-83
Note status, 5-56
Note type, 5-56
Planned End, 3-18

Priority, 3-13, 3-18
Problem, 3-24, 3-34, 5-38
Quick Find, 5-99
Reason, 5-91
Resolution, 3-24, 5-38
Severity, 5-41
Start, 3-19
Status, 3-14, 3-18, 3-34, 3-37, 3-38, 5-41, 5-53
Status (Calendar page, Create Personal Task 
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enterprise system
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Mobile Application Foundation, 1-2
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Expense Type drop-down list, 5-18, 5-71
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Number field, 3-28, 3-66, 3-67
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Information, Create Service Request view, 5-40
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Information, Material Reporting view, 5-61
Information, Service Request Details view, 5-35, 
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Information, Time Reporting view, 5-58
Information, Transfer Parts, 5-90

parts global icon, 3-5
Pentium I processor, 2-1
Pentium III processor, 4-1
person icon, 5-29, 5-36
personal task, definition of, 3-19, 5-25
Planned Effort field, 3-18, 5-49
Planned End Date field, 5-49
Planned End drop-down list, 3-18
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